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Introduction to NTA Level 4 Practicum 

 Guide 

 

Overall Aim of the Practicum Guide 

The practicum guide has been developed to guide students 

to effectively learn in laboratory practical areas to transfer 

the theoretical knowledge into practice. It provides an 

opportunity for students to practice newly learned skills 

under the supervision and support of tutors and practical 

instructors. This practicum guide provides guidance on 

required areas for rotation, specific skills to be learnt and 

tasks to be completed. This guide also attempts to promote 

standardization of the training in the laboratory settings; 

to ensure that students in all medical laboratory training 

institutions have same competences to be acquired for 

graduation. 

Layout and Organization of the Practicum Guide 

The practicum is organized into six major sections as 

follows: 

Section I: Overview of the practicum which covers the 

overall aim of the practicum and definition of terms such 

as ‘practicum’, ‘practical rotation’. The overview section 

also describes the structure, practicum areas, prerequisite, 

advance preparation, monitoring and evaluation. 
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Section II: This section describes the practical teaching 

team which includes tutors, instructors and students. The 

section also covers roles and responsibilities of the team 

and addresses the patient/client as an important resource 

who plays a key role in the laboratory practical learning 

of students.  

Section III: This section explains practical competences 

according to NTA level 4, summary of practical 

competencies, aims, practical learning objectives, 

practical opportunities and prerequisites.  

Section IV: This section contains a summary of all the 

practicum modules and their allocated time per week 

including specific guidance for NTA Level 4 Semester I 

practicum modules. Included in each module are the 

overall aim, practical learning objectives, competencies, 

practicum resources, prerequisites, practical placement, 

specific activities/assignments, end of practicum 

assignment, monitoring and evaluation, and checklists 

specific to each practicum module. 

Section V: This section contains a summary of all the 

practicum modules and their allocated time per week 

including specific guidance for NTA Level 4 Semester II 

practicum modules. Included in each module are the 

overall aim, practical learning objectives, competencies, 

practicum resources, prerequisites, practical placement, 

specific activities/assignments, end of practicum 
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assignment, monitoring and evaluation, and checklists 

specific to each practicum module. 

Who is the Practicum Guide For? 

This practicum guide is intended primarily for use by all 

students to learn in the practical setting. 

How Should the Practicum Guide be used? 

The practicum guide is intended to be used as a tool by 

students to learn the appropriate skills as stipulated in the 

curriculum. 

Practical Procedure Books 

• Students shall be provided with Practical Procedure 

Books at the beginning of the academic year. The 

Practicum Guide has been harmonised with the 

Practical Procedure Book as a guide for performing 

most of the procedures listed in the Practical 

Procedure Book. Students should be encouraged to 

practice skills at all the times in laboratory settings and 

use both the Practical Procedure Book and Practicum 

Guide for the acquisition of skills. 

• The tutor or practical instructor assigned for signing 

the student Practical Procedure Book should only do 

so after being satisfied that he/she has coached, 

supported and observed the student performing a task. 
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Section I: Overview of the Practicum 

Overall Aim of Laboratory Practical Training 

The aim of the training is to expose students to the entire 

range of activities in the health facility while rotating 

through the different laboratory departments, students 

will acquire relevant skills to enable them to provide or 

participate in the delivery of services at their respective 

levels. The practical training will be given over the entire 

instructional period of each semester. 

 

Purpose of the Practicum 

The practicum is a practical attachment intended to give 

students opportunities for supervised practical hands-on 

application of theoretical concepts studied in class during 

the current or past semester. The practicum may be a brief 

activity or could last longer. 

Laboratory rotation/placement 

This is a form of practicum where students are attached to 

health facility laboratory (dispensary, health centre and 

hospital) area for a specified period of time in order to 

learn the intended skills. At the site they have more 

interaction with patients and staff and have some 

responsibilities. During the laboratory placement, 

responsibility for teaching relies on both practical 

instructors and tutors. The practical time has to be utilized 

appropriately through organization of classroom and 
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practical hours for students to have enough time for 

effective acquisition of skills. 

Structure of Practicum Areas 

During NTA Level 4 Semester I, students will spend 7 

hours a week in the laboratory setting. During NTA Level 

4 Semester II, students will spend 13.5 hours a week in 

the laboratory setting.  

In order to have successfully completed the practical 

training, students should demonstrate competences in 

Laboratory instrumentation, Routine laboratory 

investigation, Computer application and Laboratory 

reagents and solutions. 

 

Practicum Modules per Semester 

• The following are NTA Level 4 Semester I practicum 

modules: 

o MLT04101 Laboratory instrumentation (60 

Practical hours) 

o MLT04102 General Human Anatomy and 

Physiology (40 Practical hours) 

o MLT04103 Laboratory Safety and Waste 

Management (40 Practical hours) 

o MLT04104 Communication and life skills (20 

Practical hours) 
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• The following are NTA Level 4 Semester II practicum 

modules: 

o MLT04207 Routine laboratory investigation 

(60 Practical hours) 

o MLT04208  Laboratory Specimen 

Management (40 Practical hours) 

o MLT04209 Computer application (70 

practical hours) 

o MLT04210 Systemic Human Anatomy and 

Physiology ( 20 Practical hours) 

o MLT04211 Laboratory reagents and solution 

(80 Practical hours) 

 

Prerequisites 

For NTA Level 4, students should have completed the 

required theoretical preparation. These prerequisites are 

discussed in each respective section for each area of 

practice. 

Practicum Resources 

• Laboratory rotation plan 

• Practicum Guide  

• Practical Procedure Book 

 

Advance Preparation 

For all practical procedures, students should be introduced 

to the skills in class/skills laboratory through 

demonstrations, simulations and role plays. 
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Practical Teaching 

Tutors and Practical Instructor have the responsibility to 

supervise, guide and teach students in the laboratory 

setting. They also have responsibility of documenting 

student progress by making appropriate entries or 

endorsing procedures completed in the students’ Practical 

Procedure Books and relevant checklists. The roles and 

responsibilities of different staff in student learning are 

highlighted in section II of this practicum guide. 
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Section II: The Practical Teaching Team and 

Their Roles 

Implementation of practical training requires the 

collaborative efforts of tutors, practical instructors and 

students. Each of these groups has different roles in the 

teaching and learning process. The relationship between 

members of the practical teaching team and students is 

important. Tutors, practical instructor and students must 

communicate clearly with each other during the learning 

process. Students will gain the most from their 

experiences when feedback is given constructively in the 

spirit of promoting learning. Students are not expected to 

know how to do everything perfectly at once, but rather, 

they are in the process of learning to improve upon their 

current skills and learn new ones. The practical instructor 

or tutor will work with each student or a group of students 

during the process of practical learning and teaching. The 

tutor and practical instructor will be responsible to 

monitor, evaluate, and give constructive feedback on 

students’ learning. The students will have the opportunity 

to seek guidance from and provide feedback to the tutors 

and practical instructors. 
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Figure 1: Roles and Responsibilities of Tutors, Practical 

instructorand Students 

 

 
 

Roles and Responsibilities of the Student in Practical 

Setting 

Students are expected to show diligence in practical areas 

and behave in a way that is consistent with ethical 

practice. Students will have the following roles: 

• Learn the laboratory setting leadership, policies, 

routine and procedures 

• Learn practical skills according to practical learning 

objectives 
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• Present performed practical summaries, challenges 

encountered and other assignments to practical 

instructors and tutors as relevant 

•  Perform other duties as assigned by Practical 

Staff/Instructors at the relevant site 

• Complete assignments and submit them to the 

relevant practical instructor or tutor as appropriate 

• Maintain laboratory records correctly 

• Support fellow students in the practical areas for 

effective learning 

• Share practical learning experiences in classroom and 

laboratory. 

• Receive feedback from tutors and practical instructors 

on progress and discuss/ask questions 

• Provide feedback to tutors and practical instructors on 

practical teaching and learning process 

 

NOTE: Other specific roles will depend on the specific 

area in which the student will be placed. 

 

Patient/Client as a Resource 

Patient/Client is a very important resource and plays a key 

role in the practical learning of students. He/she is a 

constant resource for students as source of laboratory 

specimens. However, the patient/client has rights which 

tutor, medical laboratory staff/instructor and student have 

to observe as they interact with the patient/client. These 

rights include: 
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• Being treated with compassion, love and respect. 

• Getting correct information about his/her tests 

requested and procedures. 

• Complaining and appealing in accordance with 

established procedures. 

• The right to privacy and confidentiality. 

• Refusing services if they do not meet the required 

needs and standards. 

• Accessing health services, facilities and information 

according to their needs. 

• The right for informed consent, self-expression and 

choice of care. 

• Knowing health facility rules and regulations that 

apply to his/her conduct as a patient. 
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Section III. Practical Competences According 

to NTA Level 4 

Introduction 

NTA Level 4 students (Basic Laboratory Technicians) are 

expected to apply professional ethics and code of conduct 

in performing routine medical laboratory duties including 

collecting and analyzing routine specimens, preparing 

basic reagents, operating laboratory equipment, keeping 

records and documents in health service facilities. 
 

Table 1: Summary of practical Competences According to NTA 

Level 4 

 P
r
in

c
ip

a
l 

O
u

tc
o

m
es

 

By the end of the NTA Level 4 rotation students will be able to: 

• Apply principles of customer care to provide health laboratory 

services 

• Apply safety principles to manage laboratory operations 

• Employ principles of computer in record keeping to handle 

laboratory information 

• Apply standard procedures to prepare laboratory reagents and 

solutions for performing laboratory  investigations 

• Apply standard procedures to diagnose diseases 

• Apply principles of laboratory instrumentation to facilitate 

disease diagnosis 

N
T

A
 L

e
v
e
l 

4
 

Semester Subject Areas 
Training 

Sites  Tasks for Semester I 
Tasks for 

Semester II 

• Apply preventive measures 

correctly in handling 

laboratory equipment  

• Application of 

aseptic procedures 

in specimen 

collection 

• Autonomous 

laboratory 

(level C) 
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• Operate laboratory 

equipment/instruments 

properly 

• Troubleshoot common 

problems in basic laboratory 

instruments / equipment 

• Apply procedures for caring 

of basic laboratory 

instruments/equipment 

• Maintain equipment 

inventory properly in the 

laboratory 

• Prepare official letter, 

curriculum vitae, meeting 

minutes, memo and notice 

• Apply fingerspell alphabet 

in sign to special group in 

providing laboratory 

services. 

• Apply negotiation skills. 

• Locate organs involved in 

blood formation and 

lymphatic system. 

• Locate muscles of the upper 

limb and lower limbs where 

blood vessels for blood 

sample collection lie  

• Able to select 

specimen 

containers 

correctly 

• Collecting 

specimens 

according to 

Standards (SOPs) 

• Preparation of basic 

laboratory reagents 

and solutions 

• Perform routine 

investigations 

correctly in the 

laboratory 

• Practice computer 

skills effectively in 

the laboratory. 

• Locate sites and 

blood vessels of 

the lower limb, 

upper limb and 

other special sites 

for blood 

collection (heel, 
big toe, dorsal 

pedis femoral, 

finger, ventral side 

of the hand and 

cubital area, ear 

lobe and temporal 

site) 

• Dispensary 

and health 

centre 

laboratory 

• Skills 

laboratory 

• Hospital 

laboratory 

• Computer 

laboratory 
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Aim 

The overall aim of the NTA Level 4 practicum is to 

enable a trainees to acquire the necessary skills in 

laboratory instrumentation, routine laboratory 

investigations, reagent preparation and solution and 

computer to confidently solve day-to-day problems in 

health care settings.  

 

Specifically, students will be prepared to continue on to 

NTA Levels 5. To this end, the following outcomes have 

been established for students: 

• Apply computer skills in performing laboratory 

investigation (LIS). 

• Utilize skills for preparing reagents and solutions for 

routine laboratory investigations. 

• Utilize skills for infection, prevention and control 

(IPC) to prevent and control infectious diseases 

• Perform routine laboratory diagnostic methods to 

detect diseases 

• Apply procedures for operating and caring laboratory 

instruments/equipments 

• Troubleshoot common problems in basic laboratory 

instruments / equipment. 

• Prepare official letter, curriculum vitae, meeting 

minutes, memo and notice in improving 

communication at the working environment. 

• Apply fingerspell alphabet signs to special group 

when providing laboratory services 
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Practical Learning Outcomes 

By the end of NTA level 4 practicum students are 

expected to be able to: 

• Apply principles of customer care to provide health 

laboratory services 

• Apply safety principles to manage laboratory 

operations 

• Employ principles of computer in record keeping to 

handle laboratory information 

• Apply standard procedures to prepare laboratory 

reagents and solutions for performing laboratory  

investigations 

• Apply standard procedures to diagnose diseases   

 

Practical Competencies/Skills 

• Practical competencies/skills are specified in each 

module below  

 

Practical Opportunities  

During NTA level 4 at medical laboratory schools, 

students will be oriented to specific practical areas and 

will: 

• Be trained for a professional world (Practical 

skills).Where they will practise thinking and acting 

like professional Medical Laboratory Technologists 

by experiencing the equipment, protocols and 

working environment of a real medical laboratory 

which fits their needs. 
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• Gain Intellectual skills through producing data from 

practical acquire, processes, analyse and interpret. 

Achieving this; requires application, analysis and 

evaluation, higher order thinking skills which add 

value to their profession. 

• Gain Personal / transferable skills due to working 

together with medical laboratory staffs and enhance 

their effective communication and organization. 

 

Prerequisites 

Before starting the practicum, students should have had 

theoretical preparation. However for this level, students 

will go to practical areas at the same time as they are 

receiving educational training. These exposures are brief 

and related to the particular area covered during class 

sessions. 
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Section IV: Semester I Practicum Modules 

Students will be placed in practical settings for acquisition 

of skills during the training of the following three (3) 

practicum modules (see table below). 

Table 2: Semester I Practicum Modules 

Module Code and Title 

Scheme of Study  

(Hours per week) 

Practica

l 
Practicum Activity 

MLT04101 Laboratory 

Instrumentation  3 

Caring,  operating and 

troubleshooting  

instruments/equipment

s  

MLT04102 General Human 

Anatomy and Physiology 

2 

Locate lymphatic 

system and muscles of 

the upper limb and 

lower limbs for 

sample collection. 

MLT04103 Laboratory 

Safety and Waste 

Management  

2 
Applying IPC 

measures 

MLT04104 

Communication and life 

skills  

1 

Prepare official letter, 

CV, meeting minutes, 

memo and note 

Total hours 8 
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Practicum Module: MLT04101 Laboratory 

Instrumentation 

 

Total Practical Time: 60 hours in 20 

weeks of a 

semester 

 

Aim: The aim of practical session is for students to 

acquire skills of operating, caring and troubleshooting 

instruments/equipment in the laboratory setting. 

 

Practical Learning Outcomes: 

By the end of practicum, students are expected to be able 

to: 

• Use basic instruments and equipment to conduct 

laboratory tests. 

• Apply procedures for caring of basic laboratory 

instruments/equipment 

• Troubleshoot common problems in basic laboratory 

instruments / equipment 

• Report non-conformances of basic laboratory 

instruments/equipment 
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Competences/Skills 

• Operate instrument and equipment according to 

manufacturer manuals and or SOPs 

• Use performance monitoring tools (the temperature 

chart, maintenance log) 

• Perform care of basic laboratory 

instruments/equipment  

• Assemble materials for care of basic equipment and 

instruments  

• Report non-conformances of laboratory instruments 

and equipment 

• Fill corrective action log sheet for basic laboratory 

equipment/instruments 

 

Practicum Resources 

• Practicum checklists 

• Practical assignment sheets 

• Equipment/ instruments 

• Practical Procedure Books (PPB) 

 

Prerequisite modules 

• None 
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Practical Placement and Assignments 

During placement in the hospital laboratory department, 

students will get the opportunity to perform practical 

activities, assignments and demonstrations. In each area 

students will have an opportunity to observe, perform and 

acquire different skills and to see how those skills are 

applied in different settings.  
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Activity1: Operating instruments and equipment. 

 

In the Clinical chemistry section, Haematology section,  

Parasitology section, Microbiology section, Sterilization room and 

other relevant areas, students will be assigned to the activities of 

laboratory instrumentation as follows: 

• Operate Microscope, centrifuges, weighing balances, incubators, 

refrigerators and colorimeter 

 
Assignment 1 

Each student shall be assigned to operate Microscope, Centrifuges, 

Weighing balances, Incubators, Refrigerators, Water bath, Distiller, 

Hot air oven and Colorimeter. Write and submit to the practical 

instructor a report showing how he/she operated those equipments 

while dealing with patient samples. 

 

Activity 2: Using performance monitoring tools of the 

equipment/ instruments 

In the Clinical chemistry section, Haematology section,  

Parasitology section, Microbiology section, Sterilization room and 

other relevant areas, students will be assigned to the activities of 

laboratory instrumentation as follows: 

• Use the temperature chart and maintenance log for monitoring 

refrigerator, microscopes, centrifuges, autoclave and hot air 

oven. 

 
Assignment 

Each student shall be assigned to use the temperature chart and 

maintenance log for monitoring refrigerator, microscopes, 

centrifuges, autoclave and hot air oven. Write and submit filled tools 

to the practical instructor 
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Activity 3: Reporting non-conformances of laboratory 

instruments and equipment 

In the Clinical chemistry section, Haematology section,  

Parasitology section, Microbiology section, Sterilization room and 

other relevant areas, students will be assigned to the activities of 

laboratory instrumentation as follows: 

• Report non-conformances and fill corrective action log sheet for 

distiller, autoclave, micropipette and microscope 

 

Assignment  

Students shall document the non-conformances and troubleshoot all 

common problems of the distiller, autoclave, micropipette and 

microscope. Write and submit report to the practical instructor. 

 
Activity 4: Performing care of basic laboratory 

instruments/equipment  

In the Clinical chemistry section, Haematology section,  Parasitology 

section, Microbiology section, Sterilization room and other relevant 

areas, students shall be divided into small manageable groups of 4 to 

6 students per group  to rotate into the identified areas above; and be 

assigned to the following activity: 

• Perform care of Microscope, centrifuges, weighing balances, 

incubators, refrigerators, colorimeter, autoclave, hot air oven and 

distiller 

Assignment 1 

Each student shall be assigned to perform care of Microscope, 

Centrifuges, Weighing balances, Incubators, Refrigerators, 

Colorimeter, Autoclave, Hot air oven and Distiller. Instruct students 

to write report and submit to the practical instructor 
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Activity 5: Filling corrective action log sheet for basic laboratory 

equipment/instruments 

In the Clinical chemistry section, Haematology section,  Parasitology 

section, Microbiology section, Sterilization room and other relevant 

areas, students shall be divided into small manageable groups of 4 to 

6 students per group  to rotate into the identified areas above; and 

assigned to the following activity: 

• Fill corrective action log sheet for basic laboratory 

equipment/instruments 

Assignment 

Each student shall fill  corrective action log following the 

identification of non-conformances of Microscope, Centrifuges, 

Weighing balances, Incubators, Refrigerators, Colorimeter, 

Autoclave, Hot air oven and Distiller.  Students shall write report 

and submit to the practical instructor 
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Checklist 1: Operating of Light Microscope 

Skills 

Standard  Criteria 

1.1 Procedure  of 

operating 

microscope 

1.1.1 Connects the light microscope to a power source. 

1.1.2 Turn the revolving nosepiece putting the lowest objective lens in 

position. 

1.1.3 Mount slides with specimen onto the stage.  

1.1.4 Keep the slide with specimen in place with the metal clips   

1.1.5 Look into the eyepiece and focus into specimen. 

1.1.6 Adjust the condenser for the maximum amount of light 

depending on objective lens and nature of specimen (wet or dry 

stained smear). 

1.1.7 Visualize the field with x10 objective lens  
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Skills 

Standard  Criteria 

1.1.8 Visualize the field with x40 objective lens  

 1.1.9 Visualize the field with x100 objective lens using oil immersion.  

 1.1.10 Rotate the fine adjustment knob to obtain a clearer image. 

 1.1.11 Examine the specimen. 

 1.1.12 Remove the slide from the stage 

 1.1.13 Wipe oil from x100 objective and microscope stage using lens 

paper 

 1.1.14  Switche off the microscope and disconnects from the power 

source 
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Checklist 2: Care and Safety Precautions when Operating Microscope 

 

  

Skills 

Standard Criteria  

2.1 Safety Precautions 

when Operating 

Microscope 

2.1.1 Clean lenses with lens paper 

2.1.2 Wipe the stage and disinfects the eyepiece with an alcohol-

based wipe. 

2.1.3 Turn off the light source when the microscope is not in use. 

2.1.4 Carrie the microscope using two hands  

2.1.5 Store the microscope properly by lowering the nosepiece, and 

placing the objective lenses on the lowest setting.  

2.1.6 Cover the microscope after use  
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Checklist 3: Troubleshooting Laboratory Equipment/Instruments 

 

  

Skills 

Standard Criteria  

 3.1 Procedure  of 

troubleshooting 

laboratory equipment 

3.1.1 Read the operating manual. 

3.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

3.1.3 Report major breakdown of equipment  
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Checklist 4: Operating Centrifuge 

 

 

 

Skills 

Standard Criteria  

4.1 Procedure  of 

operating centrifuge  

4.1.1 Connect the centrifuge to the proper power supply 

4.1.2 Place the sample into the centrifuge symmetrically 

4.1.3 Seal tightly all tubes and safety cups. 

4.1.4 Close the lid of the centrifuge 

4.1.5 Set speed and time. 

4.1.6 Start the centrifuges 

4.1.7 Open the centrifuge lid and Removes the sample 

 4.1.8 Switch off the centrifuge   

 4.1.9 Disconnect the equipment from the power source at the end of 

the day work 
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Checklist 5: Care and Safety Measures when Operating Centrifuge 

 

Skills 

Standard Criteria  

5.1 Safety Measures 

when Operating 

Centrifuge 

5.1.1 Clean and disinfects after use. 

5.1.2 Lubricate O-rings and rotor threads. 

5.1.3 Balance the centrifuge rotor  

5.1.4 Inspect the rotor and tube cavities for signs of damage  

 
If using a swinging bucket rotor, follow these additional workplace 

practice controls: 

 5.1.5 Put metal buckets in place. 

 5.1.6 Load samples symmetrically to axis of rotation. 

 If using a fixed angle rotor, follow these additional workplace practice 

controls: 

 5.1.7 Tighten rotor lid correctly. 

 5.1.8 Install and attach rotor to spindle. 

 5.1.9 Pull up on the rotor to confirm rotor is attached. 
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Checklist 6: Troubleshooting of Centrifuge 

  

Skills 

Standard Criteria  

6.1 Procedure  of 

troubleshooting 

centrifuge 

6.1.1  Read the operating manual. 

6.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

6.1.3 Report major breakdown of equipment  
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Checklist 7: Operating Weighing Balance  

 

  

Skills 

Standard Criteria  

7.1 Procedure  of 

operating weighing 

balance 

7.1.1 Level the weighing balance 

7.1.2 Place a piece of filter paper on the pan 

7.1.3 Zero the weighing balance 

7.1.4 Place the chemical on a filter paper using spatula.  

7.1.5 Add the chemical slowly until the desired weight 

7.1.6 Remove the chemical from the weighing balance 

7.1.7 Turn of the weighing balance 

 



Practicum Guide for Tutors and Instructors NTA Level 4 Medical Laboratory 33 

Checklist 8: Care and Safety Measures when Operating Weighing Balance  

 

  

Skills 

Standard Criteria  

8.1 Care and Safety 

Measures when 

Operating weighing 

balance 

8.1.1 Clean the weighing balance with a damp cloth 

8.1.2 Clean any spilt chemical with dry gauze 

8.1.3 Turn off the weighing balance after use 
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Checklist 9: Troubleshooting of Weighing Balance 

 

 

  

Skills 

Standard Criteria  

9.1 Procedure  of 

troubleshooting 

Weighing balance 

9.1.1  Read the operating manual. 

9.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

9.1.3 Report major breakdown of equipment  
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Checklist 10: Operating Autoclave  

Skills 

Standard Criteria  

10.1Procedure of 

Operating 

Autoclave 

10.1.1 Loosen the caps of the containers to be sterilized 

10.1.2  Pour distilled water or rain water into the autoclave 

10.1.3  Place the basket in the autoclave 

10.1.4  Close the lid and screws down the lid clamps 

10.1.5  Open the air outlet valve 

10.1.6  Turn on the heat source 

 10.1.7 Close the air outlet valve when the air has expelled and 

temperature gauge reads 1040C 

 10.1.8 Wait until the gauge reads 1210C 

 10.1.9 Reduce the heat after 15 minutes when the gauge reads 1210C 

 10.1.10Turn off the autoclave and waits until gauge reads 00C 

 10.1.11 Open the outlet  

 10.1.12 Open the lid 
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Checklist 11: Care and Safety Precautions when Operating Autoclave 

Skills 

Standards Criteria 

11.1Care and Safety 

Precautions when 

Operating 

Autoclave 

11.1.1  Use only distilled water or rainwater in an autoclave to avoid 

salt deposits 

 11.1.2 Check water level if sufficient for one cycle 

 11.1.3 Pack materials to be sterilized as per autoclave bucket capacity 

 11.1.4 Open the lid after the pressure gauge reaches zero 

 11.1.5 Clean the inside of the autoclave with a cloth dampened in 

distilled water after use 

 11.1.6  Clean the pressure and safety valves using a swab moistened 

with distilled water. 

 11.1.7 Lubricate the autoclave clamps using high melting point grease  

 11.1.8 Lubricate the sealing face of the gasket with high melting point 

grease to prevent permanent wear and failure of the gasket. 
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Checklist 12: Troubleshooting an Autoclave 

 

  

Skills 

Standard Criteria  

12.1Procedure of 

troubleshooting of 

Autoclave 

12.1.1  Read the operating manual. 

12.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

12.1.3 Report major breakdown of equipment  
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Checklist 13: Operating Colorimeter 

Skills 

Standard Criteria 

13.1Procedure  of  

Operating 

Colorimeter 

13.1.1 Connect the unit to the power supply and switch on. 

13.1.2 Wait for 5 minutes for colorimeter to warm-up  

13.1.3 Select the correct wavelength for the compound to be tested 

13.1.4 Select absorbance by using the mode switch 

13.1.5  Arrange blank, standard and test solutions in test tube rack 

 13.1.6 Clean a cuvette using soft tissue to avoid scratches 

 13.1.7 Transfer the blank solution into the cuvette  

 13.1.8 Place the cuvette in the sample compartment with the clear 

sides of the cuvette facing the light path. 

 13.1.9  Close the chamber and zero the calorimeter  

 13.1.10 Remove the cuvette from the compartment 

 13.1.11Pour the standard solution into the cuvette and reads the 

absorbance 

 13.1.12Pour the test solution into the cuvette and reads the absorbance 

 13.1.13Switch off the instrument  

 13.1.14Disconnect from power supply after use 
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Checklist 14: Care and Safety Precautions when Operating Colorimeter 

 

 

  

Skills 

Standard  Criteria  

14.1 Care and Safety 

Precautions when 

Operating 

Colorimeter 

 

 

14.1.1 Keep the cuvette chamber closed when not in use. 

14.1.2 Clean filters with a soft cloth or cotton gauze when required 

(for non-inbuilt filters). 

14.1.3 Switch off the equipment after use 

14.1.4 Disconnect from power source after use. 
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Checklist 15: Troubleshooting of Colorimeter 

  

 

 

  

Skills 

Standard Criteria  

15.1Procedure  of 

troubleshooting 

Colorimeter 

15.1.1   Read the operating manual. 

15.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

15.1.3 Report major breakdown of equipment  
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Checklist 16: Operating Refrigerator 

 

  

Skills 

Standard Criteria  

16.1 Procedure  of 

operating 

Refrigerator 

16.1.1 Plug in the refrigerator onto the power source 

16.1.2 Switch on the power source  

16.1.3 Set the correct temperature (2-8℃) for the refrigerator 

16.1.2 Open and closes the door gently to avoid disturbing the contents 
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Checklist 17: Care and Safety Precautions when Operating Refrigerator 

Skills 

Standard  Criteria  

17.1 Care and Safety 

Precautions when 

Operating 

Refrigerator 

 

17.1.1 Clean the refrigerator  

17.1.2 Defrost and cleans the freezer compartment 

17.1.3 Dry the freezer compartment with a clean cloth  

17.1.4 Wipe with glycerine or 70% methanol onto the walls to make it 

easier to defrost next time 

17.1.5 Wash the rubber lining on the door with soap and water. 

17.1.6 Remove dirt and dust from the coils and condenser using a soft 

brush. 

17.1.7 Place the refrigerator away from the wall  

17.1.8 Close the door to prevent warm air entering the cooling chamber. 
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Checklist 18: Troubleshooting of Refrigerator 

  

  

Skills 

Standard Criteria  

18.1Procedure  of 

troubleshooting of 

Refrigerator 

18.1.1 Read the operating manual. 

18.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

18.1.3Report major breakdown of equipment  
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Checklist 19: Operating Water Bath 

 

Skills 

Standard Criteria  

19.1Procedure of 

Operating Water 

Bath 

19.1.1 Put water in the water bath 

19.1.2 Connect the unit to the main power supply. 

19.1.3  Set the temperature control to the desired temperature. 

19.1.4  Switch on the main switch 

19.1.5  Incubate vials or test tubes of samples in the water bath 

19.1.6 Remove vials or test tubes of samples after incubation 

19.1.7 Close the lid of the water bath after use and when not in use. 
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Checklist 20: Care and Safety Precautions when Operating Water Bath 

 

Skills 

Standard Criteria  

19.2Care and Safety 

Precautions when 

Operating Water 

Bath 

19.2.1 Clean the water bath trough using distilled water and 

disinfectant 

19.2.2  Check container for water leaks during cleaning of the trough 

19.2.3   Use distilled water or rainwater in the water bath 

19.2.4   Change distilled water in the water bath trough when needed 

19.2.5 Clean the water bath trough using distilled water and 

disinfectant 

19.2.6  Check container for water leaks during cleaning of the trough 

19.2.7   Use distilled water or rainwater in the water bath 
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Checklist 21: Troubleshooting of Water bath 

 

  

Skills 

Standard Criteria  

21.1Procedure  of 

troubleshooting 

Water bath 

21.1.1 Read the operating manual. 

21.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

21.1.3 Report major breakdown of equipment  
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Checklist 22: Operating Incubator 

 

  

Skills 

Standard Criteria  

22.1 Procedure of 

Operating Incubator 

22.1.1 Switch on the instrument  

22.1.2 Set the desired temperature 

22.1.3 Arrange articles to be incubated  

22.1.4 Close the door 
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Checklist 23: Care and Safety Precautions when Operating Incubator 

Skills 

Standard   Criteria  

23.1 Care and Safety 

Precautions when 

Operating Incubator 

 

23.1.1 Close the door fully when in use 

23.1.2 Clean the incubator using non-corrosive disinfectant 

23.1.3 Wipe with a damp cloth soaked in soapy water. 

23.1.4 Lubricate the mechanical parts of the door lock 

23.1.5 Protect the incubator from power surges using a voltage stabiliser 
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Checklist 24: Troubleshooting of Incubator 

 

 

  

Skills 

Standard Criteria  

24.1Procedure  of 

troubleshooting 

Incubator 

24.1.1 Read the operating manual. 

24.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

24.1.3 Report major breakdown of equipment  
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Checklist 25: Operating Water Distiller 

Skills 

Standard Criteria  

25.1 Procedure of 

Operating Water 

Distiller 

25.1.1 Connect the distiller to the main power supply  

25.1.2 Switche on the main power supply 

25.1.3  Connect the pressure hose to the water tap and turn on the water 

supply 

25.1.4  Switche on the distiller 

 25.1.5 Check the drained water flows freely and does not 'back-up' into 

the level control.  

 25.1.6 Switche off the distiller when the reservoir is full  

 25.1.7 Turn off water supply  

 25.1.8 Disconnect from the mains power supply after use  
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Checklist 27: Care and Safety Precautions when Operating Water Distiller 

 

  

Skills 

Standard  Criteria  

27.1 Care and Safety 

Precautions when 

Operating Water 

Distiller 

 

27.1.1 Tur on the electricity supply when the heating element is 

completely immersed in water 

27.1.2 Puts in sufficient cool running water to feed the condenser 

27.1.3 Clean the distiller 

27.1.4 Switche off the distiller after use 
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Checklist 28: Troubleshooting of Distiller 

 

 

  

Skills 

Standard Criteria  

28.1Procedure of 

troubleshooting 

Distiller 

28.1.1 Read the operating manual. 

28.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

28.1.3 Report major breakdown of equipment  
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Checklist 29: Using Micropipette 

Skills 

Standard Criteria  

29.1 Procedure of using  

Micropipette 

29.1.1 Set the desired volume  

29.1.2 Select the correct size of tips to be used 

29.1.3  Attach the tip firmly to the micropipette 

29.1.4 Presse the push-button of the pipette with a thumb to the first stop 

of the micropipette 

 29.1.5 Immerse the pipette tip vertically into the solution  

 29.1.6 Release the button to move up to the top stop position by 

releasing the thumb slowly and smoothly 

 29.1.7 Place the pipette tip at 450 angle against inside the wall of the 

receiving container 
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Skills 

Standard Criteria  

 29.1.8 Empty the tip by slowly pressing the push-button down to the 

first stop 

 29.1.9 Empty completely by presses down the push-button to the final 

stop 

 29.1.10 Release the push-button to return to the top stop position. 

 29.1.11 Discard the tip 

 29.1.12 Place the pipette back into respective stands after use. 
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Checklist 31: Care and Safety Precautions when Operating Micropipette 

 

  

Skills 

Standard Criteria  

31.1Care and Safety 

Precautions when 

Operating 

Micropipette 

31.1.1 Decontaminate and cleans outside of the micropipette with 70% 

methanol or ethanol 

31.1.2 Place the micropipette in the respective rack after use 
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Checklist 32: Troubleshooting of Micropipette 

 

 

  

Skills 

Standard Criteria  

32.1Procedure  of 

troubleshooting 

Micropipette 

32.1.1 Read the operating manual 

32.1.2 Report major malfunctions of equipment  
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Checklist 33: Operating pH Meter 

 

Skills 

Standard Criteria  

33.1Procedures for 

Operating pH Meter 

33.1.1  Place the equipment on clean and flat surface  

33.1.2  Connect the equipment to the main power supply and switches 

on 

33.1.3  Rinse the electrodes with deionized water  

33.1.4  Dip the electrodes in sample solution   

33.1.5  Read the pH results 

33.1.6  Clean the equipment after pH reading 

33.1.7  Report the reading  



Practicum Guide for Tutors and Instructors NTA Level 4 Medical Laboratory 58 

Checklist 34: Care and Safety Precautions when Operating pH Meter 

  

Skills 

Standard Criteria  

34.1 Care and Safety 

Precautions when 

Operating pH Meter 

34.1.1  Wash the electrodes in  deionized water  

34.1.2 Store the electrodes in storage medium of solution  

34.1.3 Wipe the glass electrode bulb with tissue paper 

 34.1.4 Disconnect the instrument from power supply after use 
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Checklist 35: Troubleshooting of pH Meter 

 

 

 

 

Skills 

Standard Criteria  

35.1Procedure of 

troubleshooting pH 

Meter 

35.1.1 Read the operating manual 

35.1.2 Check the electric socket outlet, plug and fuse, if the 

equipment/instrument fails to switch on 

35.1.3 Report major breakdown of equipment  
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Practicum Module: MLT04102 General Human Anatomy and Physiology 

 

 

 

Total Practical Time: 40 hours in 20 weeks of a semester  

 

Aim: The aim of this practicum is for students to acquire skills of human anatomy and physiology in 

providing health care services. 

 

Practical Learning Outcomes: 

By the end of practicum the students will be able to: 

• Locate  organs involved in blood formation  

• Locate  organs involved in lymphatic system  

• Locate  muscles of upper limb were blood vessels (medial cubital vein, cephalic vein and basilic 

vein) lie 

• Locate  muscles of lower limbs were femoral vein lie  

Competencies/Skills 

• Show and name organs involved in blood formation  

• Show and name organs involved in lymphatic system 
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• Show and name muscles of upper limb were blood vessels lie 

• Show and name muscles of lower limbs were femoral vein lie 

Practicum Resources 

• Practicum learning Outcomes 

• Manikins 

• Charts 

• Models 

 

Prerequisite modules 

• None 

 

Areas of Practice and Assignment 

Students will have an opportunity while on placement in the Skill laboratory to familiarise with organs 

for blood formation and areas used for blood collections. Tutors and skills laboratory instructors and 

other staff should ensure that students learn the following: 
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Activity 1: At the Skill laboratory 

At the end of theory session which contain practical component(s) the students shall be divided in 

small manageable groups (4-6 students) and assigned to identify and familiarise with organs for 

blood formation, lymphatic system, muscles of upper and lower limbs and areas used for blood 

collections. 
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Practicum Module: MLT04103 Laboratory Safety and Waste Management 

 

 

 

Total Practical Time:40 hours in 20 weeks of a semester  

 

Aim: The aim of this practicum is for students to acquire and apply safety skills and aseptic methods 

in managing laboratory operations. 

 

Practical Learning Outcomes: 

By the end of practicum, the students will be able to: 

• Use 6S laboratory principles in improving working area 

• Use protective gears in laboratory practices to maintain safety 

• Use fire fighting techniques in laboratory accidents 

• Use different methods of laboratory waste disposal to maintain safety in working environment 

• Use personal protective equipment to maintain safety in laboratory premises 

• Apply IPC guidelines to manage personal protective equipment in health facilities 
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Competences/Skills 

• Clean blood collection sites using antiseptic as per SOP 

• Disinfect working bench and floor using appropriate disinfectant 

• Wash hands as needed during laboratory practices as per SOP 

• Decontaminate laboratory wares as per SOP 

• Sterilize laboratory wares as per SOP (dry heat, moist heat and chemical) 

• Put on and take off protective gears during laboratory practices as per SOP (gloves, lab coats, 

goggles, masks, eye wears, gumboot, apron) 

• Apply 6S in the laboratory practices (Sort/Select, Set, Shine, Standardize, Sustain, Safety) 

• Sterilize laboratory materials as per SOP 

• Use and monitor laboratory safety tools (first aid kit, spill kit, emergence shower, eye wash, 

biosafety cabinet and safety hood) 

• Extinguish fire using available firefighting equipment in the laboratory (fire extinguisher, sand 

basket, water horse) 

• Segregate and dispose wastes according to nature of wastes 

• Decontaminate bins and other laboratory materials by using appropriate disinfectant 

 

Practicum Resources 

• Practicum learning Outcomes 
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• Checklists 

• PPE 

• IPC guidelines 

 

Prerequisite modules 

• None 

 

Practical Placement and Assignments 

• During placement in the hospital laboratory department, students will get the opportunity to 

perform practical activities, assignments and demonstrations. In each area students will have an 

opportunity to observe, perform and acquire different skills and to see how those skills are applied 

in different settings. 

 

Activity 1: in the Laboratory 

Students shall perform the following activities: 

• Clean blood collection sites using antiseptic as per SOP 

• Disinfect working bench and floor using appropriate 

disinfectant 

• Wash hands as needed during laboratory practices as per SOP 
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• Put on and take off protective gears during laboratory 

practices as per SOP  

• Decontaminate laboratory wares as per SOP 

• Sterilize laboratory wares as per SOP (dry heat, moist heat and 

chemical) 

• Apply 6S in the laboratory practices (Sort/Select, Set, Shine, 

Standardize, Sustain, Safety) 

• Sterilize laboratory materials as per SOP 

• Use and monitor laboratory safety tools (first aid kit, spill kit, 

emergence shower, eye wash, biosafety cabinet and safety 

hood) 

• Extinguish fire using available firefighting equipment in the 

laboratory (fire extinguisher, sand basket, water horse) 

• Segregate and dispose wastes according to nature of wastes 

• Decontaminate bins and other laboratory materials by using 

appropriate disinfectant 

Assignment 

Each student shall write a report and submit to the tutor for 

assessment and feedback. 
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Checklist 36: Cleaning blood collection sites using antiseptic 

 

Skills 

Standard Criteria  

36.1 Procedure for 

Cleaning blood 

collection sites 

using antiseptic 

36.1.1 Wash hands  

36.1.2 Wear appropriate personal protection equipment (PPE)  

36.1.3 Clean site with alcohol swabs in a circular motion  

36.1.4 Wait for the alcohol to dry 
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Checklist 37: Disinfection of working bench and floor 

 

Skills 

Standard Criteria  

37.1 Procedure for 

Disinfection of 

working bench 

and floor 

37.1.1 Dispose absorbent materials  

37.1.2 Minimize clutter and other unnecessary items on countertops and 

desks/tables 

37.1.3 Clean dirty surfaces 

37.1.4 Apply disinfectant  

37.1.5 Wipe the surface to dry and/or remove residual disinfectant 

37.1.6 Store disinfectants in accordance to manufacturer labels  

37.1.7 Dispose cleaning materials in trash containers 
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Checklist 3: Hand washing 

Skills 

Standard Criteria  

3.1 Procedure for 

Hand washing 

3.1.1 Wet hands with running water 

3.1.2 Apply soap  

3.1.3 Rub all areas of hands: palms,  fingers,  fingernails and between 

fingers 

3.1.4 Rinse hands with clean running water 

3.1.5 Use a paper towel when turning off tap if is not elbow controlled or 

automatic shut off 

3.1.6 Dry hands with a paper towel   
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Checklist 38: Donning and doffing gloves  

 

Skills 

Standard Criteria  

38.1Procedure for 

donning and doffing   

gloves  

Donning gloves 

38.1.1 Take out a glove from the box 

38.1.2 Hold the glove by the top edge of the cuff only as you slip 

your fingers into it 

38.1.3 Don the first glove by pulling it on, holding it by the top edge 

of the cuff 

38.1.4 Take a second glove from the box 

38.1.5 Transfer the glove to the gloved hand by the edge of the cuff 

38.1.6 Insert bare fingers into the glove 

38.1.7 Turn the external surface of the glove to be donned 

38.1.8 Pull the second glove up 
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Skills 

Standard Criteria  

Doffing gloves 

38.1.9 Pinch one glove at the wrist level to remove it 

38.1.10Peel the glove downward and away from hand 

38.1.11Hold the removed glove on the gloved hand 

38.1.12Slide the fingers of the un-gloved hand inside between the 

glove and the wrist  

38.1.13Remove the second glove by rolling it down the hand and over 

the top of the first glove 

38.1.14Discard the removed gloves in an appropriate waste container 
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Skills 

Standard Criteria  

38.1.15Clean hands with soap and water or alcohol-based hand 

sanitizer 
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Checklist 39: Waste segregation  

 

Skills 

Standard Criteria  

39.1Procedure for 

Waste 

Segregation  

39.1.1 Dispose sharp materials in sharp box 

39.1.2 Dispose highly infectious materials in red bin 

39.1.3 Dispose infectious materials in yellow bin  

39.1.4 Dispose all non-infectious materials in black or green bin  
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Practicum Module: MLT04104 Communication and Life 

skills 

 

 

 

Total Practical Time: 20 hours in 20 weeks 

of a semester 

 

Aim: The aim of practical session is for students to acquire 

and apply communication and life skills in the laboratory 

setting. 

 

Practical Learning Outcomes: 

By the end of practicum, students are expected to be able to: 

• Apply communication skills in customer care to provide 

laboratory services 

• Apply writing skills in improving communication at 

working environment. 

• Apply sign language to communicate with special group 

to provide laboratory services 

 

Competencies/Skills 

• Demonstrate effective communication skill when 

attending clients 

• Prepare official letter 

• Prepare curriculum vitae 

• Prepare meeting minutes  

• Prepare memo and notice 
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Practicum Resources 

• Practicum checklists 

• Practical assignment sheets 

 

Prerequisites modules: 

• None 

 

Practical Placement and Assignments 

During placement in Phlebotomy section, Laboratory 

reception, Skills laboratory and other relevant departments, 

students will get the opportunity to gain communication and 

life skills through activities, assignments and demonstrations. 

In each area students will have an opportunity to observe and 

acquire different skills and to see how those skills are applied 

in different settings 

 

Activity1: Phlebotomy section, Laboratory reception and 

Other relevant areas 

In the above mentioned areas, instruct students to perform the 

following activity 

• Communicate with clients during provision of service 

Assignment 1 

Each student shall write a report and submit to the tutor for 

assessment and feedback 

 

Assignment 2 
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Instruct each student to prepare curriculum vitae indicating 

personal particular, education background, field/working 

experience (if applicable), hobbies and two referees. 

  

Assignment 3 

Instruct each student to prepare one official letter indicating 

writers address, recipient organization/ person address, date, 

reference number, title, main message, signature of the writer.   

 

Assignment 4 

Instruct each student to write an internal memo indicating date, 

addressor, addressee, heading, contents and signature. 

 

Assignment 5 

Instruct each student to write meeting minutes indicating date, 

heading, participants, agenda, content and closure. 

 

All assignment reports shall be submitted to the tutor for 

assessment and grading 
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Monitoring and Evaluation 

• Practical teaching team will make daily observations of 

students, provide support and document progress using 

checklists provided 

• The Practical teaching team will give timely feedback 

for student’s improvement 

• Tutors/practical instructors will find opportunities for 

students to learn a maximum number of tasks stipulated 

in the NTA Level 4 Practicum Guide 

• The students’ reports shall be assessed and graded for 

assessment and evaluation purposes and then an 

immediate feedback shall be given to the student 
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Checklist 40: Communication Skills and Customer care 

Skills 

Standard Criteria 

40.1Creating rapport with the 

patient/client 

40.1.1 Welcome the patient/client to a seat 

40.1.2 Greet the patient/client 

40.1.3 Introduce him/herself to the patient/client 

40.2Utilizing communication 

skills 
40.2.1 Maintain eye contact throughout the discussion   

40.2.2 Talk to the patient/client in simple, clear language 

and audible voice. 

40.2.3 Show patience by not rushing the patient/client  

40.2.4 Does not interrupt the patient/client  

40.2.5 Act non-judgemental by trying to understand and 

not rushing to conclusions 

40.2.6 Do not get distracted by other things 

40.2.7 Use encouragers (e.g ‘mhmh’, nodding, ‘yes, yes’) 

40.2.8 Check for understanding by paraphrasing or 

reflecting to what the patient/client is saying 

40.2.9 Call patient/client by their first name  
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Skills 

Standard Criteria 

40.2.10 Show concern for the patient/client by 

acknowledging their emotions and feelings 

40.2.11 Use appropriate body gestures and postures 

40.2.12Observe patient/clients body gestures(language) 

and interprets correctly 

40.3Collecting information  40.3.1 Follow a logical sequence 

40.3.2 Respond to leads from the patient/client 

40.3.3 Allow the patient/client to express his/her concerns 

40.3.4 Listen actively and attentively to the patient/client 

concerns  

40.3.5 Use both open and closed ended questions 

40.3.6 Summarise information and allows the 

patient/client to correct errors 

40.3.7 Provide Feedback appropriately 

40.3.8 Record all information correctly in the appropriate 

patient/client’s record 
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Practicum Module: MLT04207 Routine Laboratory 

Investigation 

 

 

Total Practical Time: 60 hours in 20 weeks of a 

semester 

 

Aim: The goal of practicum is for students to acquire and apply 

basic laboratory skills in processing and examining specimens to 

provide test results at the health facility. 

 

Practical Learning Outcome: 

By the end of practicum, students are expected to be able to: 

• Apply skills of performing routine laboratory investigations 

• Apply turnaround time (TAT) in providing health laboratory 

services 

• Apply principles of quality assurance in performing routine 

laboratory investigations 

 

Competencies/Skills: 

• Develop turnaround time  worksheet for routine laboratory 

investigations (Locate time, evaluate time and develop TAT) 

• Perform routine Parasitological tests (BS, MRDT, urinalysis, 

stool analysis) 

• Perform routine Hematological tests (haemoglobin estimation 

using Haemoglobinometers) 

• Perform routine Microbiological tests (Ziehl Nelsen Hot, 

rapid syphilis test, urine pregnancy test, rapid Hepatitis B and 

C test and rapid HIV test) 
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• Perform routine Clinical Chemistry test (routine urine 

biochemical tests using Multistix and blood glucose test using 

Glucometer) 

• Perform daily quality control testing, prepare positive and 

negative controls for routine tests. 

Practicum Resources: 

• Practical rotation plan 

• Practical assignment sheets 

• Checklists  

• All necessary working tools/supplies  

Pre-requisite modules 

• Laboratory instrumentation 

• Laboratory Safety and Waste Management 

• Laboratory ethics and code of conduct 

Practical Attachment 

During the practical attachment in hospital laboratory, students 

will get opportunities to learn skills in Laboratory reception, 

haematology, blood transfusion, parasitology, microbiology and 

other related area. Students will have an opportunity to observe, 

practice, and acquire different skills under supervision in the 

above mentioned areas.  

Activity 1:  Reception, Phlebotomy, Haematology, Microbiology,  

Parasitology, clinical chemistry sections and other relevant areas  

Divide students into small manageable groups that will rotate in 

Reception, Phlebotomy, Haematology, Microbiology,  Parasitology, 

clinical chemistry sections and other relevant areas to observe and 

practice the following: 

• Examine blood for  malaria parasites (BS and MRDT), 

Haemoglobin, Hepatitis B and C, HIV and syphilis 

• Examine urine for pregnancy, parasites and biochemical analytes 
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• Examine sputum using  Ziehl Nelsen Hot 

• Examine stool for parasites 

 

Assignment 1 

Assign each student to examine urine for UPT and biochemical analytes, 

sputum for ZN hot, blood for BS, MRDT, Haemoglobin, hepatitis B and C, 

HIV and syphilis, stool for parasites. Instruct each student to write report 

and submit to the practical instructor  

 

Assignment 2 

Assign each student to document patient data and test results into the 

register books. Instruct each student to write report and submit to the 

practical instructor/tutor  

 

Activity 2: At the Microbiology and  Parasitology sections 

Instruct each students to perform the following; 

• Prepare positive and negative controls for routine tests 

• Perform daily quality control testing 

 
Assignment 

Instruct each student to write report and submit to the practical 

instructor/tutor 
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Monitoring and Evaluation 

• Practical teaching team will make daily observations of 

students, provide support and document progress using 

checklists provided 

• The Practical teaching team will give timely feedback for 

student’s improvement 

• Tutors/practical instructors will find opportunities for 

students to learn a maximum number of tasks stipulated in 

the NTA Level 4 Practicum Guide 

• The students’ reports shall be assessed and graded for 

assessment and evaluation purposes and then an immediate 

feedback shall be given to the student 
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Checklist 41: Performing Malaria Rapid Diagnostic Test (MRDT) 

Skills 

Standard Criteria 

41.1 Procedure  of 

performing  Malaria 

Rapid Diagnostic 

Test 

41.1.1 Assemble important equipment, materials and supplies: 

• Paper towels  

• Gloves 

• blood collection device( capillary tube, inverted cup 

and pipette) 

• Disposal bucket  

• Marker pen/pen or pencil 

• Safety box 

• Standard diagnostic MRDT kit  

• Sterile lancet 

• Cotton 
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Skills 

Standard Criteria 

• Alcohol swab 

41.1.2 Wash hands with soap and water and dry with dry paper 

towel 

41.1.3 Put on gloves 

41.1.4 Remove the test device from the foil and place it on flat 

surface 

41.1.5 Write the patient’s identification number on the device 

41.1.6 Disinfect the fingertip site with alcohol swab 

41.1.7 Prick the fingertip with a sterile lancet 

41.1.8 Apply gentle pressure to the finger until the finger 

express the first blood drop 

41.1.9 Wipe the first drop of blood away with a dry cotton 

wool 
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Skills 

Standard Criteria 

41.1.10 Apply gentle pressure until a new blood drop appears  

41.1.11 Collect blood by using blood collection device( 

capillary tube, inverted cup and pipette) 

41.1.12 Touch the blood collecting device into the sample well 

and allow the blood to be drawn into the device 

41.1.13 Place the appropriate number of drops of buffer 

solution into the buffer well 

41.1.14 Leave it on bench at room temperature for 10 minutes 

41.1.15 Report the findings in the investigation form and 

appropriate register 

 41.1.16 Wash hand with soap and water after the procedure 
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Checklist 42 : Staining of Blood Smear by Giemsa and Field Stain  

 

Skill 

Standard Criteria 

42.1Procedure of 

Staining 

blood smear 

by Giemsa 

stain 

42.1.1 Assemble the important equipment, materials and supplies: 

• 10% Giemsa staining reagent  

• Gloves  

• Glass slide 

• Jars  

• Slide rack  

• Waste disposal containers  

42.1.2 Wash hands with soap and water 

42.1.3 Dry hands with paper towel  

42.1.4 Put on gloves  

42.1.5 Place the slide smear on the staining rack  
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Skill 

Standard Criteria 

42.1.6 Flood the smear with the 10% Giemsa solution  

42.1.7 Wash off the stain with running tap water  

42.1.8 Air dry the smear on the rack 

42.1.9 Discard wastes in the appropriate containers  

42.1.10Put off gloves and washes hands with soap and water  

42.1.11Dry hands with paper towel  

42.2Procedure of 

Staining 

blood smear 

by Field stain 

42.2.1 Assemble the important equipments, materials and supplies: 

• Gloves  

• Slide 

• Jars (with field stain) 

• Slide rack 

42.2.2 Wash hands with soap and water before handling the sample 

42.2.3 Dry hands with paper towel 
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Skill 

Standard Criteria 

42.2.4 Put on gloves 

42.2.5 Stain by dipping the slide, keeping it steady, into the jars 

42.2.6 Dip in fields stain A 

42.2.7 Clean the slide with water  

42.2.8 Dip in fields stain B  

42.2.9 Clean the slide with water 

42.2.10 Leave the slide to air dry on the slide rack 

42.2.11 Remove gloves 

42.2.12 Washes hand with soap and water 
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Checklist 43: Routine Urine Examination (Macroscopy and Microscopy) 

 

Skill 

Standard Criteria 

43.1Procedure of 

routine urine 

examination 

43.1.1 Assemble the following equipment materials and supplies: 

• Paper towels 

• Gloves 

• Centrifuge 

• Microscope 

• Transfer pipette 

• Slides 

• Safety box 

• Waste disposal container 

43.1.2 Washe hands with soap and water  

43.1.3 Dry hands with paper towel 

43.1.4 Put on gloves 
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Skill 

Standard Criteria 

Macroscopic 

examination 

43.1.5 Inspect the urine for colour, turbidity and presence of blood 

43.1.6 Report macroscopic findings  

Microscopic 

Examination 

43.1.7 Pour urine from the container into a tube 

43.1.8 Place a tube with urine into centrifuge rotors 

43.1.9 Centrifuge the urine at 3000rpm for 5 minutes 

43.1.10Remove the tube with sample from the centrifuge rotor 

using forceps 

43.1.11Discard the supernatant into the sink with running water 

43.1.12Collect 1drop of urine sediment on a clean slide using 

transfer pipette 

43.1.13Cover the preparation by using cover slip 

43.1.14Place the slide on the microscope stage 

43.1.15Visualize the field with x10 objective lens 
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Skill 

Standard Criteria 

43.1.16Examine the preparation under x40 objective for detailed 

examination 

43.1.17Discard cover slips and glass slides 

2.1.7 Report microscopic findings 

2.1.8 Wash hands with soap and water 

 2.1.9 Dry hands with paper towel 

  



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory                                                                

93 

Checklist 44: Biochemical (Analytes) Urine Examination 

 

Skill 

Standard Criteria 

44.1Procedure of urine 

examination for 

analytes(Biochemical) 

using multistix 

(blood, glucose, 

ketones, biliribin, 

urobilinogen,Ph,  

protein, nitrite, leucocyte, 

specific gravity) 

44.1.1 Assemble the following equipment, materials and 

supplies: 

• Soap 

• Paper towels 

• Gloves 

• Waste disposal container 

• Container with Multistix 

44.1.2 Wash hands with soap and water 

44.1.3 Dry hands with paper towel 

44.1.4 Put on gloves  

44.1.5 Take one strip from bottle and replaces a cap 

44.1.6 Dip the test area of strip in urine and removes 

immediately 
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Skill 

Standard Criteria 

44.1.7 Tap edge of strip against blotting paper to remove 

excess urine  

44.1.8 Leave it for 1 minutes to allow the reaction to take 

place 

44.1.9 Compare test area with colour chart on the container 

of strips 

44.1.10 Report the reading 

44.1.11 Discard the used materials  

44.1.12 Remove gloves  

 44.1.13 Wash hands with soap and water 
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Checklist 45: Routine Stool Examination 

Skill 

Standard Criteria 

45.1Procedure 

for routine 

stool 

examination 

45.1.1 Assemble  equipment, reagent and materials: 

• Slides 

• Cover slips  

• Marker pen/pencil 

• Sample (stool sample) 

• Gloves 

• Normal saline 

• Applicator stick 

• Microscope 

• Cotton balls/swabs 

45.1.2 Label the slide with patient laboratory number using a grease 

pencil or lead pencil 
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Skill 

Standard Criteria 

45.1.3 Wash hands with soap and water 

45.1.4 Dry hands with paper towel 

45.1.5 Put on gloves 

Macroscopic 

Examination 

45.1.6 Inspect the stool for colour, consistency, mucus ,blood and 

visible parasite with naked eyes  

45.1.7 Report the macroscopic findings  

Microscopic 

examination of 

stool 

45.1.8 Place a drop of physiological saline on a clean labelled slide 

45.1.9 Select a portion of stool specimen that appears abnormal  

45.1.10Take a small stool sample with wooden applicator stick 

45.1.11Emulsify with the saline on the Microscope slide 

45.1.12Cover the emulsified stool sample with cover slip 

45.1.13Disposes applicator stick and container in appropriates 

disposal bucket  

45.1.14Place the slide on the microscope stage 
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Skill 

Standard Criteria 

45.1.15Visualize the field with x10 objective lens 

45.1.16Examine the preparation under x40 objective for detailed 

examination 

45.1.17Discard cover slips and glass slides 

45.1.18Report microscopic findings 

45.1.19Switch off the microscope after use 

45.1.20Cleans the microscope using a dry peace of cotton gauze 

45.1.21Cover the microscope with appropriate cover 

 45.1.22Wash hands with soap and water or antiseptic 
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Checklist 46: Estimating Blood Haemoglobin Level 

 

Skills 

Standard Criteria 

46.1Procedures 

of 

Estimating 

hemoglobin 

level Using 

the 

Hemocue 

method 

46.1.1 Assemble important equipment, materials and supplies: 

• Gloves 

• Pipettes 5 mls 

• Hemocue machine 

• QC solution 

• A test tube  

• A clean cuvette 

• Sterile lancet 

46.1.2 Start up the Hemocue machine  

46.1.3 Wash hands with soap and water 

46.1.4 Dry hands by using paper towel 

46.1.5 Put on gloves 
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Skills 

Standard Criteria 

46.1.6 Clean patient’s finger with antiseptic wipe  

46.1.7 Prick side of finger with sterile lancet 

46.1.8 Apply light pressure until the first blood drop appears 

46.1.9 Wipe away first  blood drop 

46.1.10 Re-apply light pressure towards fingertip until another drop of 

blood appear 

46.1.11 Fill microcuvete in one continuous process 

46.1.12 Wipe off any excess blood outside of the microcuvette 

46.1.13 Check that no air bubbles are present in the microcuvette 

46.1.14 Place microcuvette in the cuvette holder 

46.1.15 Push cuvette holder to reading position 

46.1.16 Read the Hb results 

46.1.17 Report the Hb results 

46.1.18 Remove the cuvette  
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Skills 

Standard Criteria 

46.1.19Dispose the cuvette in the waste bin 

46.1.20Turn off Haemocue Machine 

46.1.21Wash hands with soap and water after the procedure 
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Checklist 47:  Ziehl-Neelsen Hot Technique 

Skill 

Standard Criteria 

47.1Procedure 

for preparing 

smear for 

Ziehl-

Neelsen Hot 

Technique 

47.1.1 Assemble the following equipment, materials and supplies: 

• Sputum sample 

• Marker pen 

• Gloves 

• Waste disposal container 

• Applicator stick / wire loop 

• Spirit lamp 

• Glass slides  

• Grease / lead pencil 

• Phenol/ Jik 

47.1.2 Wash hands with soap and water  

47.1.3 Dry hands with paper towel  
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Skill 

Standard Criteria 

47.1.4 Put on gloves 

47.1.5 Use new slides when preparing sputum smear 

47.1.6 Clean the slide with alcohol and wipes dry or passes briefly 

through flame 

47.1.7 Label the slide with the laboratory/ specimen number on the 

frosted end of slide using a lead pencil  

47.1.8 Open/ uncap the container carefully  

47.1.9 Pick out a portion of sputum which appears abnormal  using 

wooden applicator stick or loop 

47.1.10Spread the sputum on the middle of the slide in rotational 

movement  

47.1.11Fix the smear by passing over a flame two to three times 

47.1.12Place fixed sputum smear on a staining rack 
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Skill 

Standard Criteria 

47.1.13Discard the cap and the container in a bucket containing phenol 

for disinfection  

47.1.14Take off gloves  

47.1.15Wash hands with soap and water  

47.2Procedure 

for 

Performing a 

Ziehl - 

Neelsen Hot 

Technique 

staining 

47.2.1 Assemble the following equipment, materials and supplies: 

• Sputum smear 

• Microscope 

• 25% sulphuric acid  

• 0.3% Methylene blue  

• Strong Carbolfuchsin 

• Gloves 

• Waste disposal container 

• Spirit lamp 

• Phenol/ Jik 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory                                                                

104 

Skill 

Standard Criteria 

47.2.2 Washes hand with soap and water and dries it with paper towel  

47.2.3 Put on gloves  

47.2.4 Flood the smear with filtered strong Carbolfuchsin stain 

47.2.5 Heat underneath the smear using a burning cotton swab soaked 

in methanol until vapour just begins to rise 

47.2.6 Allow the heated stain to remain on the slide for 5 minutes 

47.2.7 Wash off the stain with clean water 

47.2.8 Decolourise with 25% sulphuric acid until the stain is no longer 

decolourizable 

47.2.9 Wash well with clean water 

47.2.10 Counter stains the smear by covering with 0.3% methylene 

blue or malachite green stain for 1 minute 

47.2.11Wash the smear in thin stream of clean water  
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Skill 

Standard Criteria 

47.2.12Clean the back of the slide with cotton wool or gauze  

47.2.13Place it upright in a drying rack for the smear to air-dry at room 

temperature 

47.2.14Discard the used materials in appropriate waste disposal 

containers  

47.2.15Put off gloves  

47.2.16Wash hands with soap and water 

47.2.17Dry hands with paper towel  

47.3Examining 

the smear 

under the 

microscope 

47.3.1 Put on new gloves  

47.3.2 Mount the slide onto the microscope stage  

47.3.3 Visualize with x 10 objective  

47.3.4 Examine with x 100 oil immersion objective 
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Skill 

Standard Criteria 

47.3.5 Discard the used materials in the appropriate waste disposal 

containers 

47.3.6 Put off gloves  

47.3.7 Report the findings in the laboratory investigation form and 

register 

 47.3.8 Wash hands with soap and water 
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Checklist 48: Hepatitis and Syphilis Rapid Testing  

Skills 

Standard Criteria 

48.1Procedure 

for rapid 

Hepatits B 

and C(HB 

and HCV) 

testing  

48.1.1 Assemble important equipment, materials and supplies: 

• Paper towels  

• Gloves 

• Plastic transfer pipette 

• Absorbent pad 

• Disposal bucket  

• Marker pen 

• Safety box 

• Standard diagnostic HBV or HCV kit  

 

48.1.2 Wash hands with soap and water 

48.1.3 Dry hands with paper towel 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory                                                                

108 

Skills 

Standard Criteria 

48.1.4 Put on gloves 

48.1.5 Remove the strip from the packet 

48.1.6 Place the strip on a flat surface 

48.1.7 Pipette required amount of plasma/ serum/whole blood into 

device well 

48.1.8 Put the specimen to the absorbent pad of  the strip 

48.1.9 Add three drops of essay diluents to the whole blood specimen 

48.1.10Read results after 10-20 minutes  

48.1.11Discard all wastes in appropriate container 

48.1.12Remove gloves 

48.1.13Report results in the investigation form and  register book 

 48.1.14Wash hands with soap and water 
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Skills 

Standard Criteria 

48.2Syphilis 

rapid testing 

by use of 

Syphilis kit 

48.2.1 Assemble important equipment, materials and supplies: 

• Paper towels 

• Gloves 

• Disposable pipette 

• Syphilis kit 

• Marker pen 

• Safety box 

• Disposal container 

• Buffer reagent 

48.2.2 Wash hands with soap and water  

48.2.3 Dry hands with paper towel 

48.2.4 Put on gloves  
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Skills 

Standard Criteria 

48.2.5 Remove device from package  

48.2.6 Place the device on a flat surface 

48.2.7 Label device with client identification number 

48.2.8 Collect specimen using the disposable pipette 

48.2.9 Add two drops of specimen to the sample port in the device 

48.2.10Add two drops of the appropriate buffer reagent to sample port 

48.2.11Read results after 10-20 minutes  

48.2.12Discard all wastes in appropriate container 
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Skills 

Standard Criteria 

48.2.13Remove gloves 

48.2.14Report results in the investigation form and  register book 

 48.2.15Wash hands with soap and water 
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Checklist 49: Rapid HIV Testing 

 

Skill 

Standard Criteria 

49.1Procedure 

of HIV 

rapid 

testing by 

use of SD 

Bioline 

49.1.1 Assemble important equipment, materials and supplies: 

• Gloves 

• Paper towels 

• Standard diagnostic Bioline kit 

• Marker pen 

• Safety box 

• Waste disposal container 

49.1.2 Wash hands with soap and water 

49.1.3 Dry hands with paper towel 

49.1.4 Put on gloves 

49.1.5 Remove the testing devise from a packet  

49.1.6 Place the device on a flat surface 
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Skill 

Standard Criteria 

49.1.7 Label it with patient’s identification number 

49.1.8 Pipette required amount of plasma/serum/whole blood into a 

device well  

49.1.9 Add three drops of essay diluent 

49.1.10Read the results after 10 to 20 minutes 

49.1.11Discard all wastes in appropriate container 

49.1.12Remove gloves 

49.1.13Report the results in investigation forms and appropriate 

register 

49.1.14Wash hands with soap and water 

49.2 HIV rapid 

testing by 

use of 

Unigold 

49.2.1 Assembles important equipment, materials and supplies: 

• Paper towels 

• Gloves 

• Disposable pipette 
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Skill 

Standard Criteria 

• Unigold kit 

• Marker pen 

• Safety box 

• Disposal container 

• Wash reagent 

49.2.2 Washes hands with soap and water  

49.2.3 Dries hands with paper towel 

49.2.4 Puts on gloves  

49.2.5 Removes device from package 

49.2.6 Places the device on a flat surface 

49.2.7 Labels device with client’s identification number 

49.2.8 Collects specimen using the disposable pipette 

49.2.9 Adds two drops of specimen to the sample port in the device 
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Skill 

Standard Criteria 

49.2.10Adds two drops of the appropriate buffer reagent to sample 

port 

49.2.11Reads the results after 10-20 minutes 

49.2.12Discards all wastes in appropriate container 

49.2.13Removes gloves 

49.2.14Reports the results in the laboratory investigation form and in 

the laboratory register book 

 49.2.15Washes hand with hands soap and water 

 

 

 

 

 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory                                                                

116 

Checklist 50: Urine Pregnancy Test 

Skills 

Standards Criteria 

50.1Procedure 

for Urine 

Pregnancy 

Test(UPT)  

50.1.1 Assembles important equipment, materials and supplies: 

• Paper towels  

• Gloves 

• Disposal bucket  

• Standard diagnostic UPT kit  

• Pipette 

 

50.1.2 Washes hands with soap and water 

50.1.3 Puts on gloves 

50.1.4 Removes the pregnancy strip from the pouch 

50.1.5 Dips the strip in a urine container up to a mark labelled “max” 

50.1.6 Removes the strip from the urine container  

50.1.7 Places the strip on a flat surface 
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Skills 

Standards Criteria 

50.1.8 Waits for the colored lines  to appear 

50.1.9 Reads the results after 5 minutes 

50.1.10Discards all wastes in appropriate container 

50.1.11Removes gloves 

50.1.12Reports the results in investigation forms and appropriate 

register 

 50.1.13Washes hands with soap and water 
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Checklist 51: Measuring Blood Glucose Level 

 

Skill 

Standard 

Operating 

Procedure 

Criteria 

51.1Measuring 

blood glucose 

level using a 

glucometer 

51.1.1 Assembles important equipment, materials and supplies: 

• Gloves 

• Glucose strips 

• Glucometer 

• Sterile lancet 

• Alcohol swab 

51.1.2 Washes hands with soap and water 

51.1.3 Dries hands with paper towel 

51.1.4 Puts on gloves  

51.1.5 Turns on the glucometer machine 

51.1.6 Disinfects the fingertip site with alcohol swab 
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Skill 

Standard 

Operating 

Procedure 

Criteria 

51.1.7 Pricks the fingertip with a sterile lancet 

51.1.8 Applies gentle pressure to the finger until the finger 

express the first blood drop 

51.1.9 Wipes the first drop of blood away with a dry cotton wool 

51.1.10Applies gentle pressure until a new blood drop appears  

51.1.11Picks one strip from the bottle containing the glucose strip 

51.1.12Touches the strip’s slot with blood on the finger tip  

51.1.13Inserts the strip into the glucometer  

51.1.14Waits until the glucometer displays the results 

51.1.15 Reads the glucose results 
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Skill 

Standard 

Operating 

Procedure 

Criteria 

51.1.16Removes the strip from the glucometer 

51.1.17Discards the used strip and other materials in appropriate 

disposal containers 

51.1.18Puts off the gloves 

51.1.19Reports the results on investigation form and appropriate 

register 

51.1.20Places the machine in its appropriate place 

51.1.21Washes hand with soap and water 
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Practicum Module: MLT04208 Laboratory Specimen Management 

 

Total Practical Time: 40 hours in 20 weeks of a semester 

 

Aim: The goal of practicum is to enable students to acquire and apply basic laboratory skills 

in accessioning and collecting specimens for routine laboratory investigations at the health 

facility. 

 

Practical Learning Outcome: 

By the end of practicum, students are expected to be able to: 

• Apply procedures to collect specimens for routine laboratory investigations 

• Apply procedures of accessioning specimens for laboratory investigations 

• Apply Standards to maintain records of collected specimens in the laboratory 

• Select containers for specimen in the laboratory 

 

Competencies/Skills: 
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• Perform accessioning of specimen. 

• Instructs client to collect urine, stool and sputum specimens. 

• Collect capillary blood specimen by finger prick and heel prick methods. 

• Collect venous blood by venipuncture method. 

 

Practicum Resources: 

• Practical learning outcomes 

• Practical rotation plan 

• Practical assignment sheets 

• Checklists  

• All necessary working tools/supplies  

Prerequisite modules 

• All NTA level 4 modules for semester 1 

 

Practical Attachment 
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During the practical attachment in hospital laboratory, students will get opportunities to learn 

skills in Laboratory reception section, Phlebotomy section and other related area. Students will 

have an opportunity to observe, practice, and acquire different skills under supervision.  

 
Activity 1: Laboratory reception Section and Phlebotomy section and 

other relevant areas 

Students shall be divided into small manageable groups ( 4 to 6 students 

per group) that will rotate in the Laboratory reception section, 

Phlebotomy section and other relevant areas to observe and practice the 

following: 

• Accession urine, stool, sputum and blood specimens 

• Instructs client to collect urine, stool and sputum specimens 

• Collect capillary blood by finger prick and heel prick 

• Collect venous blood by venipuncture method 

Assignment 1 

Each student will be required to apply skills on how to collect urine, sputum 

and stool for routine laboratory investigations. Each student shall write 

report and submit to the practical instructor/tutor. 
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Assignment 2 

Each student shall be required to apply skills of collecting blood for routine 

laboratory investigations. Each student shall write report and submit to the 

practical instructor/tutor. 

Assignment 3 

Each student shall be required to apply skills of accessioning laboratory 

specimen for routine laboratory investigations. Each student shall write 

report and submit to the practical instructor 
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Checklist 52: Venous Blood Collection 

 

Standard Skills 

 

 

Criteria 

52.1Procedure for 

venous blood 

collection. 

52.1.1 Washes hands with soap and water 

52.1.2 Dries hands with paper towel 

52.1.3 Puts on gloves 

52.1.4 Gathers the materials: 

• Needles 19 gauge, 21gauge and 23 gauge 

• Syringes 2.5mls ,5ml,10ml 

• Vacutainer needle  

• Vacutainer holder  

• Vacutainer tube/container 
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• Tourniquet 

• 70% methanol or alcohol swabs 

• Cotton wool or gauze 

• Gloves 

• Paper towel 

• Sharps box or container 

• Disposal bucket 

52.1.5 Introduces themselves 

52.1.6 Verifies the client’s name, date of birth, client’s ID 

number, protocol number, and medical record number. 

52.1.7 Directs client to sit in a comfortable position 

52.1.8 Applies the tourniquet. 

52.1.9 Asks client to make a tight fist so that the veins become 

more prominent 

52.1.10Uses the index finger to palpate for a suitable vein 

52.1.11Cleans site with alcohol swabs in a circular motion  

52.1.12Stabilizes the vein with non-dominant hand  
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52.1.13Punctures the skin at 300 angle using the vacutainer 

apparatus with dominant hand 

52.1.14Obtains blood samples using appropriate blood collection 

tubes. 

52.1.15Loosens the tourniquet if blood flows freely 

52.1.16Removes the tourniquet just before the last blood sample 

has been obtained 

52.1.17Applies a cotton wool over the puncture site  

52.1.18Withdraws the needle 

52.1.19Applies the needle safety device 

52.1.20Discards the needle with the safety device in place into the 

sharps container 

52.1.21Mixes the blood collection tubes with additives by 

inverting  

52.1.22Applies pressure to the site for 2 to 3 minutes 

52.1.23Tapes the gauze pad or  Band-Aid to the punctured site 

52.1.24Discards blood contaminated products into the biohazard 

trash. 
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52.1.25Labels the blood collection tubes 

52.1.26Verifies name and medical record number on the label in 

the presence of the client before taking the sample to the 

laboratory 

52.1.27Thanks the client 

52.1.28Removes gloves 

 52.1.29Washes hands with soap and water 

  



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 129 

 

 

 

Checklist 53: Finger prick blood collection 

     Skills 

Standard Criteria  

53.1Procedure for 

finger prick 

blood collection 

53.1.1 Washes hands with soap and water 

53.1.2 Dries hands with paper towel 

53.1.3 Puts on gloves 

53.1.4 Gather the materials: 

• 70% methanol or alcohol swabs 

• Sterile lancet/pricker 

• Cotton wool or gauze 

• Gloves 
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     Skills 

Standard Criteria  

• Paper towel 

• Sharps box or container 

53.1.5 Introduces themselves 

53.1.6 Verifies the client’s name, date of birth, client’s ID number, 

protocol number, and medical record number. 

53.1.7 Directs client to sit in a comfortable position 

53.1.8 Positions patient’s palm side up  

53.1.9 Chooses the ring finger or whichever is least calloused 

53.1.10Cleans the fingertip with alcohol and allows the area to dry 

53.1.11Applies intermittent pressure to the finger to help the blood 

to flow to the surface of the finger 
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     Skills 

Standard Criteria  

53.1.12Holds the finger and places firmly a new sterile lancet off-

centre on the fingertip 

53.1.13Pricks the fingertip with a quick stabbing wrist motion 

53.1.14Discards the used lancets in the safety box 

53.1.15Wipes away the first drop from the finger tip of blood with a 

dry sterile gauze pad or cotton ball 

53.1.16Uses the next few drops of blood for the required test 

53.1.17Applies a gauze pad or cotton ball with a gentle pressure to 

the puncture site until the bleeding stops 

53.1.18Thanks the patient 

53.1.19Disposes waste materials in the appropriate container 

53.1.20Decontaminates all reusable equipment and returns to their 

appropriate places 
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     Skills 

Standard Criteria  

53.1.21Removes gloves 

53.1.22Washes hands with soap and water 
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Checklist 54: Blood collection by heel prick 

 

Skills 

Standard Criteria 

54.1procedure 

for heel 

prick blood 

collection 

54.1.1 Washes hands with soap and water 

54.1.2 Dries hands with paper towel 

54.1.3 Puts on gloves 

54.1.4 Assembles important materials: 

• Gloves 

• Cotton wool 

• Alcohol swab 

• Pricker/lancet  

• Sharps box or container 

• Waste container 
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Skills 

Standard Criteria 

54.1.5 Identifies the site of heel to puncture 

54.1.6 Cleans the site of puncture using alcohol swab. 

54.1.7 Punctures the site by using a lancet/pricker 

54.1.8 Wipes away the first drop of blood 

54.1.9 Eases thumb pressure and apply intermittent pressure. Avoid 

milking and scraping 

54.1.10Uses the next few drops of blood for the required test 

54.1.11Cleans area after blood collection is complete  

54.1.12Applies a gauze pad or cotton ball with a gentle pressure to the 

puncture site until the bleeding stops 

54.1.13Applies Band-Aid above the age of two 

54.1.14Labels specimens immediately after the draw; never before 

54.1.15Disposes waste materials in the appropriate container 
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Skills 

Standard Criteria 

 
54.1.16Decontaminates all reusable equipment and returns to their 

appropriate places 

 54.1.17Removes gloves 

 54.1.18Wash hands with soap and water 
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Checklist 55: Sample accessioning  

 

Skill 

Standard Criteria  

55.1Procedure for 

sample 

accessioning   

55.1.1 Washes hands with soap and water 

55.1.2 Dries hands with paper towel 

55.1.3 Puts on gloves 

55.1.4 Inspects specimen transport container to ensure custody seals 

are intact 

55.1.5 Opens the transport container  

55.1.6 Removes specimen and request form from transport 

container 

55.1.7 Inspects specimen containers for correct acceptance criteria  

55.1.8 Reads over the Request Form 
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Skill 

Standard Criteria  

55.1.9 Writes mode of delivery on the request form in upper right 

hand corner 

55.1.10Stamps the request form with the date received 

55.1.11Arranges specimens together with their request form 
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Practicum Module: MLT04209 Computer 

Applications 

 

 

 

Total Practical Time: 70 hours in 20 weeks 

of a semester 

 

Aim: The aim of this practicum is for students to apply basic 

computer skills in managing health facility communication 

and patient information. 

 

Practical Learning Outcomes: 

By the end of practicum, students are expected to be able to: 

• Apply Word Processing program in preparing documents 

• Apply Spreadsheet program in data processing 

• Apply presentation program in presenting laboratory 

information 

• Apply internet searching skills  in accessing web 

resources 

• Apply  internet, intranet and email skills  in 

communication 

• Apply skills of planned preventive maintenance on 

computer 
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Competencies/Skills 

• Format text in a Microsoft Word document 

• Create tables using Microsoft Word 

• Work with images in Microsoft Word 

• Prepare a word document for printing 

• Create formulas in Microsoft Excel 

• Manage Microsoft Excel worksheet 

• Create charts using MS Excel 

• Print Microsoft Excel Document 

• Create Power Point presentation  

• Format text of a PowerPoint presentation 

• Add clip art and pictures in a PowerPoint presentation 

• Add charts, diagrams and tables in a PowerPoint 

presentation 

• Add auto shapes, word art and hyperlinks in a PowerPoint 

presentation 

• Create animate slides of a PowerPoint presentation 

• Add transition to a PowerPoint presentation 

• Perform presentation using MS Power Point 

• Print a Power Point presentation 

• Search information by using Boolean operators (AND, 

OR, NOT, Quotation marks, Parenthesis) 

• Create email address  

• Compose email message and send 

• Communicate using intranet 

• Attach documents to email message 
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• Perform PPM procedures on protecting computer from 

extreme temperatures, dust and viruses  

• Remove  spyware/ adware and viruses  

• Conduct defragmentation of the computer 

 

 

Practical learning resources 

• Computers and accessories  

• Internet connection 

• Assignment sheets 

• Checklists  

 

Prerequisites 

• None  

 

 

Activity: Department of Health facility laboratory with 

LIS/Institution Computer laboratory  

 

Students will be divided into small manageable groups (4 to 6 

students per group) to work with the ICT Officer/Medical 

laboratory  practitioners of the hospital/training institution to 

perform the following: 

• Enter data in the computer and generate a data report using 

word processors 

 

http://www.mdsproductions.com/virusscan.html
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• Enter data in a spreadsheet program and generate a data 

report  

• Represent data in graphs using Excel 

• Enter data in the computer and prepare presentations using 

Microsoft power point   

• Do web searching for health related information using 

search engines such as Google, Yahoo and from databases 

such as HINARI, Pub med, and Research4life etc. 

• Create an email account, sign in, write email text and send 

to the practical instructor/tutor 

 

Assignment 1 

Each student shall be assigned to apply skills of MS word, Ms 

Excel, MS power point to generate report, enter data and 

prepare presentation respectively on any health related 

information.  Each student shall submit them to the Instructor 

 

Assignment 2 

Each student shall create an email account, sign in and send 

email to Instructor with attachment. 

 

Assignment 3 

Each student shall be assigned to do web searching for health 

related information using search engines and present them in 

writing to the Instructor. 
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Checklist 56: Microsoft word Processing in preparing documents  

 

Skills 

Standard Criteria 

56.1Opening the 

Word program 

window 

56.1.1 Clicks start menu 

56.1.2 Clicks All Program 

56.1.3 Clicks Microsoft Office  

56.1.4 Clicks Microsoft office word 

56.2Insert text 56.2.1 Moves a mouse to the location where you want text to 

appear in the document 

56.2.2 Left-clicks the mouse, the insertion point appears 

56.2.3 Types the text you want to appear using keyboard 

56.3Delete text 56.3.1 Places a cursor next to the text you want to delete 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 143 

 

Skills 

Standard Criteria 

56.3.2 Press the Backspace key on the keyboard to delete text to 

the left of the cursor 

56.3.3 Press the Delete key on the keyboard to delete text to the 

right of the cursor 

 

56.4Select text 56.4.1 Places the insertion point next to the text you want to select 

56.4.2 Left-clicks your mouse while holding it down, drag the 

mouse over the text to select it 

56.4.3 Releases the mouse button. You have selected the text. A 

highlighted box will appear over the selected text 

56.4.4 Places the insertion point next to the text you want to select 

56.4.5 Left-clicks the mouse while holding it down, drag your 

mouse over the text to select it 

56.5.1 Selects the text you want to copy 
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Skills 

Standard Criteria 

56.5Copy and 

paste text 

56.5.2 Clicks the Copy command on the Home tab 

56.5.3 Places the insertion point where you want text to appear 

56.5.4 Clicks the Paste command on the Home tab. The text will 

appear. 

56.5.5 Selects the text you want to copy. 

56.6Drag and drop 

text 

56.6.1 Selects the text you want to copy. 

56.6.2 Left-clicks your mouse, and drag the text to the location 

where you want it to appear.  

56.6.3 Releases the mouse button, and the text will appear. 

56.7Use the Save 

As command 

56.7.1 Clicks the Microsoft Office button/File. 

56.7.2 Selects Save As Word Document. The Save As dialog box 

appears 

56.7.3 Selects the location where you want to save the document  

56.7.4 Enters a name for the document 
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Skills 

Standard Criteria 

56.7.5 Clicks the Save button 

56.8Use the Save 

command 

56.8.1 Clicks the Microsoft Office button/File 

56.8.2 Selects Save from the menu 

56.9Use the 

spelling check 

feature 

56.9.1 Right-clicks the underlined word 

56.9.2 Selects the correct spelling of the word from the listed 

suggestions 

56.9.3 Left-clicks your mouse on the word 

56.9.4 Chooses to ignore an underlined word, add it to the 

dictionary, or go to the Spelling dialog box 

56.9.5 Right-clicks the underlined word  

56.10 Use the 

grammar 

check feature 

56.10.1Right-clicks the underlined word  

56.10.2Selects the correct word from the listed suggestions 

56.10.3Left-clicks your mouse on the word. It will appear in the 

document 
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Skills 

Standard Criteria 

56.11 Preview the 

document 

before printing 

56.11.1Clicks the Microsoft Office button 

56.11.2Selects Print 

56.11.3Prints Preview. The document opens in Print Preview 

format 

56.11.4Closes Print Preview to exit the preview format and make 

changes to the document 

56.12 Print 56.12.1Clicks the Microsoft Office button/File 

56.12.2Selects Print 

56.12.3Selects the pages you want to print—either all pages or a 

range of pages 

56.12.4Selects the number of copies 

56.12.5Checks the Collate box if you are printing multiple copies of 

a multi-page document 

56.12.6Selects a printer from the drop-down list 
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Skills 

Standard Criteria 

56.12.7Clicks Print 

56.13 Print via 

Quick Print 

56.13.1Clicks the Microsoft Office button/File 

56.13.2Selects Print 

56.13.3Clicks Quick Print. The document automatically prints to 

the default printer. 

56.14 Formatting 

font size 

56.14.1Selects the text you want to modify. 

56.14.2Left-clicks the drop-down arrow next to the font size box on 

the Home tab. The font size drop-down menu appears 

56.14.3Moves a cursor over the various font sizes. A live preview 

of the font size will appear in the document 

56.14.4Left-clicks the font size you want to use. The font size will 

change in the document 

56.15.1Selects the text you want to modify 
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Skills 

Standard Criteria 

56.15 Formatting 

font style 

56.15.2Left-clicks the drop-down arrow next to the font style box 

on the Home tab. The font style drop-down menu appears 

56.15.3Moves a cursor over the various font styles. A live preview 

of the font will appear in the document 

56.15.4Left-clicks the font style you want to use. The font style will 

change in the document 

56.16 Formatting 

font color 

56.16.1Selects the text you want to modify 

56.16.2Left-clicks the drop-down arrow next to the font color box 

on the Home tab. The font color menu appears 

56.16.3Moves a cursor over the various font colors. A live preview 

of the color will appear in the document 

56.16.4Left-clicks the font color you want to use. The font color 

will change in the document 

56.17.1Selects the text you want to modify 
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Skills 

Standard Criteria 

56.17 Use the 

bold, italic, 

and underline 

commands 

56.17.2 

Clicks the bold, italic, or underline command in the Font group on 

the Home tab 

56.18 Change the 

text case 

56.18.1Selects the text you want to modify 

56.18.2Clicks the Change Case command in the Font group on the 

Home tab 

56.18.3Selects one of the case options from the list 

56.19 Change text 

alignment 

56.19.1Selects the text you want to modify 

56.19.2Selects one of the four alignment options from the 

Paragraph group on the Home tab 

 

56.20.1Selects the text you want to format 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 150 

 

Skills 

Standard Criteria 

56.20 Formatting 

line spacing 

56.20.2Clicks the Line spacing command in the Paragraph group on 

the Home tab 

56.20.3Selects a spacing option 

OR 

56.20.4Selects Line Spacing Options. The Paragraph dialog box 

appears 

56.20.5Selects  a spacing option from the Line spacing drop-down 

menu 

56.20.6Clicks “OK” 

56.21 Change 

page 

orientation 

56.21.1Selects the Page Layout tab 

56.21.2Clicks the Orientation command in the Page Setup group 

56.21.3Left-clicks either Portrait or Landscape to change the page 

orientation 

1.22.1 Selects the Page Layout tab 
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Skills 

Standard Criteria 

56.22Change the 

paper size 
1.22.2 Left-clicks the Size command and a drop-down menu will 

appear. The current paper size is highlighted 

1.22.3 Left-clicks a size option to select it. The page size of the 

document changes 

1.23 Formatting 

page margins 

1.23.1 Selects the Page Layout tab 

1.23.2 Clicks the Margins command. A menu of options appears. 

Normal is selected by default 

1.23.3 Left-clicks the predefined margin size you want. OR 

1.23.4 Selects Custom Margins from the menu. The Page Setup 

dialog box appears 

1.23.5 Enters the desired margin size in the appropriate fields 

1.24.1 Selects the Insert tab 

1.24.2 Clicks the Header or Footer command 
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Skills 

Standard Criteria 

1.24 Insert 

Header and 

Footer 

1.24.3 Selects the desired header or footer 

1.25 Insert Page 

number 

1.25.1 Selects the Insert tab 

1.25.2 Clicks Page Number. 

1.25.3 Clicks Top of Page, Bottom of Page, or Page Margins, 

depending on where you want page numbers to appear in 

your document. 

1.25.4 Chooses a page number design from the gallery of designs 

1.26 Insert a 

break 

1.26.1 Selects an insertion point 

1.26.2 Selects the Page Layout tab 

1.26.3 Clicks the Breaks command. A menu appears 

1.26.4 Left-clicks a break option to select it 

1.27.1 Selects an insertion point 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 153 

 

Skills 

Standard Criteria 

1.27 Insert data in 

a table 

1.27.2 Selects the Insert tab 

1.27.3 Clicks the Table command 

1.27.4 Selects the number of columns and rows in the table 

1.27.5 Left-clicks your mouse and the table appear in the document 

1.27.6 Enters text into the table 

1.28 Insert 

picture 

1.28.1 Selects an insertion point 

1.28.2 Selects Insert tab 

1.28.3 Clicks the Pictures Command 

1.28.4 Browses to the picture you want to insert, select it 

1.28.5 Clicks Insert 

1.29 Insert 

symbols 

1.29.1 Selects an insertion point 

1.29.2 Clicks insert on the menu bar 

1.29.3 Select symbols. the “symbol” dialog box appear 

1.29.4 Clicks the symbols tab 
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Skills 

Standard Criteria 

1.29.5 Selects an insertion point 

1.30 Create a 

word Art 

1.30.1 Selects the Insert tab 

1.30.2 Selects the WordArt pull-down menu 

1.30.3 Clicks either Plain WordArt Styles or WordArt Transform 

Style galleries 

1.30.4 Types a text in the Edit Word Art Text box 

1.30.5 Selects the font, font size, and apply bold or italics 

1.30.6 Clicks “OK” 
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Checklist 2: Microsoft Excel in Data Processing 

Skills 

Standard Criteria 

2.1 Opening the 

Excel program 

window 

2.1.1 Clicks start menu 

2.1.2 Clicks All Programs 

2.1.3 Clicks Microsoft Office  

2.1.4 Clicks Microsoft office Excel 

2.2 Insert text 2.2.1 Left-clicks a cell to select it 

2.2.2 Enters text into the cell using your keyboard 

2.3 Edit or delete 

text 

2.3.1 Selects the cell 

2.3.2 Press the Backspace key on your keyboard to delete text 

and make a correction 

2.3.3 Press the Delete key to delete the entire contents of a cell 

2.4 Moving 

through a 

2.4.1 Selects a cell 

2.4.2 Press the Tab key to move to the right of the selected cell 
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Skills 

Standard Criteria 

worksheet 

using the 

keyboard 

2.4.3 Press the Shift key then the Tab key to move to the left of 

the selected cell 

2.4.4 Uses the Page Up and Page Down keys to navigate the 

worksheet 

2.4.5 Uses the arrow keys 

2.5 Save the 

workbook: 

2.5.1 Left-clicks the Microsoft Office button/file  

2.5.2 Selects Save or Save As 

2.5.3 Renames the file  

2.5.4 Chooses a location to save the spreadsheet 

2.6 Modifying 

column width: 

2.6.1 Positions the cursor over the column line in the column 

heading, and a double arrow will appear 

2.6.2 Left-clicks the mouse drag the cursor to the right to 

increase the column width or to the left to decrease the 

column width 
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Skills 

Standard Criteria 

2.6.3 Releases the mouse button       OR 

2.6.4 Left-clicks the column heading of a column you'd like to 

modify. The entire column will appear highlighted 

2.6.5 Clicks the Format command in the Cells group on the 

Home tab. A menu will appear 

2.6.6 Selects Column Width to enter a specific column 

measurement 

2.6.7 Selects AutoFit Column Width to adjust the column so all 

of the text will fit 

2.7  Modifying the 

row height 

2.7.1 Positions the cursor over the row line you want to modify, 

and a double arrow will appear 

2.7.2 Left-clicks the mouse, then drag the cursor upward to 

decrease the row height or downward to increase the row 

height 
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Skills 

Standard Criteria 

2.7.3 Releases the mouse button 

OR 

2.7.4 Clicks the Format command in the Cells group on the 

Home tab. A menu will appear 

2.7.5 Selects Row Height to enter a specific row measurement 

2.7.6 Selects AutoFit Row Height to adjust the row so all of the 

text will fit 

2.8 Insert rows: 2.8.1 Selects the row below where you want the new row to 

appear 

2.8.2 Clicks the Insert command in the Cells group on the Home 

tab. The row will appear 

2.9 Insert columns 2.9.1 Selects the column to the right of where you want the 

column to appear 
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Skills 

Standard Criteria 

2.9.2 Clicks the Insert command in the Cells group on the Home 

tab. The column will appear 

2.10 Deleting rows 

and columns 

2.10.1 Selects the row or column you’d like to delete 

2.10.2 Clicks the Delete command in the Cells group on the Home 

tab 

2.11 Formatting  

text in bold or 

italics 

2.11.1 Left-clicks a cell to select it, or drag your cursor over the 

text in the formula bar to select it 

2.11.2 Clicks the Bold or Italics command 

2.12 Formatting 

text as 

underlined 

2.12.1 Selects the cell or cells you want to format 

2.12.2 Clicks the drop-down arrow next to the Underline 

command 

2.12.3 Selects the Single Underline or Double Underline option 

2.13.1 Selects the cell or cells you want to format 
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Skills 

Standard Criteria 

2.13 Changing the 

font style 

2.13.2 Left-clicks the drop-down arrow next to the Font Style box 

on the Home tab 

2.13.3 Selects a font style from the list 

2.14 Changing the 

font size 

2.14.1 Selects the cell or cells you want to format 

2.14.2 Left-clicks the drop-down arrow next to the Font Size box 

on the Home tab 

2.14.3 Selects a font size from the list 

2.15 Changing the 

text color: 

1.15.1 Left-clicks the drop-down arrow next to the Text Color 

commands. A color palette will appear 

1.15.2 Selects a color from the palette 

OR 

1.15.3 Selects More Colors. A dialog box will appear 

1.15.4 Selects a color 

1.15.5 Clicks OK 
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Skills 

Standard Criteria 

2.16 Adding a 

border 

2.16.1 Selects the cell or cells you want to format 

2.16.2 Clicks the drop-down arrow next to the Borders command 

on the Home tab. A menu will appear with border options 

2.16.3 Left-clicks an option from the list to select it. 

2.17 Adding a fill 

color 

2.17.1 Selects the cell or cells you want to format 

2.17.2 Clicks the Fill command. A color palette will appear 

2.17.3 Selects a color    OR 

2.17.4 Selects More Colors. A dialog box will appear 

2.17.5 Selects a color 

2.18 Formatting 

numbers and 

dates 

2.18.1 Selects the cell or cells you want to format 

2.18.2 Left-clicks the drop-down arrow next to the Number 

Format box 

2.18.3 Selects one of the options for formatting numbers 

2.19.1 Clicks Review On the menu bar  
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Skills 

Standard Criteria 

2.19 Protect 

Workbook 

2.19.2 Selects Protect workbook 

2.19.3 Clicks protect structure and windows 

2.19.4 Selects the appropriate option(s) 

2.19.5 Enters password 

2.19.6 Re-Enters password 

2.20 Protect 

Worksheet 

2.20.1 Clicks Review On the menu bar  

2.20.2 Selects Protect Sheet, the dialog box will appear to enter 

password 

2.20.3 Enters password 

2.20.4 Re-Enters password 

2.21 Creating a 

simple 

formula that 

2.21.1 Clicks the cell where the formula will be defined (C5, for 

example) 

2.21.2 Types the equals sign (=) to let Excel know a formula is 

being defined 
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Skills 

Standard Criteria 

adds two 

numbers 

2.21.3 Types the first number to be added (e.g., 1500) 

2.21.4 Types the addition sign (+) to let Excel know that an add 

operation is to be performed 

2.21.5 Types the second number to be added (e.g., 200) 

2.21.6 Clicks the Enter button on the Formula bar to complete the 

formula 

2.22 Creating a 

simple 

formula that 

adds the 

contents of 

two cells 

2.22.1 Clicks the cell where the answer will appear (C5, for 

example) 

2.22.2 Typesthe equals sign (=) to let Excel know a formula is 

being defined 

2.22.3 Types the cell number that contains the first number to be 

added (C3, for example) 

2.22.4 Types the addition sign (+) to let Excel know that an add 

operation is to be performed 
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Skills 

Standard Criteria 

2.22.5 Types the cell address that contains the second number to 

be added (C4, for example) 

2.22.6 Press Enter, or clicks the Enter button on the Formula bar 

to complete the formula 

2.23 Creating a 

simple 

formula using 

the point-and-

click method 

2.23.1 Clicks the cell where the answer will appear (C30, for 

example) 

2.23.2 Types the equals sign (=) to let Excel know a formula is 

being defined 

2.23.3 Clicks on the first cell to be included in the formula (C5, 

for example) 

2.23.4 Types the subtraction sign (-) to let Excel know that a 

subtraction operation is to be performed 

2.23.5 Clicks on the next cell in the formula (C29, for example) 
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Skills 

Standard Criteria 

2.23.6 Press Enter, or clicks the Enter button on the Formula bar 

to complete the formula 

2.24 Creating a 

simple 

formula that 

multiplies the 

contents of 

two cells 

2.24.1 Selects the cell where the answer will appear (E32, for 

example) 

2.24.2 Types the equals sign (=) to let Excel know a formula is 

being defined 

2.24.3 Clicks on the first cell to be included in the formula (C9, 

for example), or type a number 

2.24.4 Types the multiplication symbol (*) by pressing the Shift 

key and then the number 8 key. The operator displays in 

the cell and Formula bar 

2.24.5 Clicks on the next cell in the formula or type a number (12, 

for example) 
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Skills 

Standard Criteria 

2.24.6 Press Enter, or click the Enter button on the Formula bar to 

complete the formula. 

2.25 Creating a 

simple 

formula that 

divides one 

cell by 

another 

2.25.1 Clicks the cell where the answer will appear 

2.25.2 Types the equals sign (=) to let Excel know a formula is 

being defined 

2.25.3 Clicks on the first cell to be included in the formula 

2.25.4 Types a division symbol. The operator displays in the cell 

and Formula bar 

2.25.5 Clicks on the next cell in the formula 

2.25.6 Press Enter, or clicks the Enter button on the Formula bar 

to complete the formula 

2.26.1 Clicks the cell where you want the formula result to 

appear. In this example, H6 
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Skills 

Standard Criteria 

2.26 Writing a 

complex 

formula 

2.26.2 Types the equals sign (=) to let Excel know a formula is 

being defined 

2.26.3 Types an open parenthesis, or (. 

2.26.4 Clicks on the first cell to be included in the formula (G6, for 

example) 

2.26.5 Types the addition sign (+) to let Excel know that an add 

operation is to be performed 

2.26.6 Clicks on the second cell in the formula (G7, for example) 

2.26.7 Types closed parentheses 

2.26.8 Types the next mathematical operator, or the division symbol 

(/), to let Excel know a division operation is to be 

performed 

2.26.9 Types an open parenthesis, or (. 
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Skills 

Standard Criteria 

2.26.10Clicks on the third cell to be included in the formula (D6, for 

example 

2.26.11Types the addition sign (+) to let Excel know that an add 

operation is to be performed 

2.26.12Clicks on the fourth cell to be included in formula (D7, for 

example) 

2.26.13Types closed parentheses) 

2.26.14Press Enter, or clicks the Enter button on the Formula bar. 

This step ends the formula 

2.27 Creating a 

chart 
2.27.1 Selects the worksheet you want to work with. In this 

example, we use the Summary worksheet 

2.27.2 Selects the cells you want to chart, including the column titles 

and row labels 

2.27.3 Clicks the Insert tab 
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Skills 

Standard Criteria 

2.27.4 Hover over each Chart option in the Charts group to learn 

more about it 

2.27.5 Selects one of the Chart options. In this example, we'll use 

the Columns command 

2.28 Changing the 

chart type 

2.28.1 Selects the Design tab 

2.28.2 Clicks the Change Chart Type command. A dialog box 

appears 

2.28.3 Selects another chart type 

2.28.4 Clicks OK 

2.29 Changing 

chart layout 

2.29.1 Selects the Design tab 

2.29.2 Locates the Chart Layouts group 

2.29.3 Clicks the More arrows to view all of your layout options 

2.30 Changing  

chart style 

2.30.1 Selects the Design tab 

2.30.2 Locates the Chart Style group 
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Skills 

Standard Criteria 

2.30.3 Clicks the More arrow to view all of your style options 

2.30.4 Left-clicks a style to select it 

2.31 Moving the 

chart to a 

different 

worksheet 

2.31.1 Selects the Design tab 

2.31.2 Clicks the Move Chart command. A dialog box appears. 

The current location of the chart is selected 

2.31.3 Selects the desired locations for the chart (i.e., choose an 

existing worksheet, or select New Sheet and name it) 
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Checklist 3: Enter data in the computer using presentation programs and prepare 

presentations using Microsoft power point 

 

Skills 

Standard Criteria 

3.1 Opening the 

PowerPoint 

program 

window 

3.1.1 Clicks start menu 

3.1.2 Clicks All Programs 

3.1.3 Clicks Microsoft Office  

3.1.4 Clicks Microsoft office Powerpoint  

3.2 Creating new 

presentation 

3.2.1 Clicks the Microsoft Office button/File 

3.2.2 Chooses New from the menu. The New Presentation dialog 

box will appear 

3.2.3 Clicks Blank presentation 

3.2.4 Clicks Create, and a new presentation will open in the 

PowerPoint window 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 172 

 

Skills 

Standard Criteria 

3.3 Inserting text 

into a 

placeholder 

3.3.1 Clicks inside the placeholder. The placeholder text will 

disappear, and the insertion point will appear 

3.3.2 Types your text once the insertion point is visible 

3.3.3 Clicks outside the placeholder when you have entered all of 

your text into the placeholder 

3.4 Inserting a 

new slide 

3.4.1 Clicks the New Slide command in the Slides group on the 

Home tab. A menu will appear with your slide layout options 

3.4.2 Clicks the slide you want to insert. A new slide with the 

chosen layout will appear in the center of the PowerPoint 

window and in the pane on the left 

3.5 Changing the 

layout of an 

existing slide 

3.5.1 Selects the slide you want to change 

3.5.2 Clicks the Layout command in the Slides group on the Home 

tab. A menu appears with your options 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 173 

 

Skills 

Standard Criteria 

3.5.3 Clicks an option to select it. The slide will change in the 

presentation 

3.6 Copy and 

paste a slide 

3.6.1 Selects the slide you want to copy 

3.6.2 Clicks the Copy command on the Home tab 

3.6.3 Clicks inside the Slides tab on the left task pane. A horizontal 

insertion point will appear 

3.6.4 Moves the insertion point to the location where you want the 

copy of the slide to appear 

3.6.5 Clicks the Paste command on the Home tab. The copied slide 

will appear 

3.7 Delete a slide 3.7.1 Selects the slide you want to delete. 

3.7.2 Clicks the Delete command in the Slides group on the Home 

tab 
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Skills 

Standard Criteria 

3.8 Move a slide 3.8.1 Selects the slide you want to move on the Slides tab in the left 

task pane 

3.8.2 Clicks and drag the slide to a new location. The insertion 

point will appear 

3.8.3 Releases the mouse button. The slide will appear in the new 

location 

3.9 Use the Save 

As command 

3.9.1 Clicks the Microsoft Office button/File 

3.9.2 Selects Save As. A menu will appear 

3.9.3 Selects the type of file you want to save the presentation as 

3.9.4 Types the file name 

3.9.5 Selects the location where you want to save the document 

using the drop-down menu 

3.9.6 Enters a name for the document 

3.9.7 Clicks the Save button 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 175 

 

Skills 

Standard Criteria 

3.10 Use the Save 

command 

3.10.1 Clicks the Microsoft Office button/File 

3.10.2 Selects Save from the menu 

3.11 Insert text 3.11.1 Clicks the placeholder or text box where you want to insert 

text 

3.11.2 Types the text you want to appear 

3.12 Delete text 3.12.1 Places your cursor next to the text you want to delete 

3.12.2 Presses the Backspace key on your keyboard to delete text to 

the left of the cursor 

3.12.3 Presses the Delete key on your keyboard to delete text to the 

right of the cursor 

3.13 Select text 3.13.1 Places the insertion point next to the text you want to select 

3.13.2 Clicks and drag your mouse over the text to select it 
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Skills 

Standard Criteria 

3.13.3 Releases the mouse button. You have selected the text. A 

highlighted box will appear over the selected text 

3.14 Formatting 

font size 

3.14.1 Selects the text you want to modify 

3.14.2 Clicks the drop-down arrow next to the font size box on the 

Home tab. The font size drop-down menu appears 

3.14.3 Moves your cursor over the various font sizes. A live preview 

of the font size will appear in the document 

3.14.4 Clicks the font size you want to use. The font size will change 

in the document 

3.15 Formatting 

font style 

3.15.1 Selects the text you want to modify 

3.15.2 Clicks the drop-down arrow next to the font style box on the 

Home tab. The font style drop-down menu appears 
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Skills 

Standard Criteria 

3.15.3 Moves your cursor over the various font styles. A live 

preview of the font will appear in the document 

3.15.4 Clicks the font style you want to use. The font style will 

change in the document 

3.16 Formatting 

font color 

3.16.1 Selects the text you want to modify 

3.16.2 Clicks the drop-down arrow next to the font color box on the 

Home tab. The font color menu appears 

3.16.3 Moves your cursor over the various font colors. A live 

preview of the color will appear in the document 

3.16.4 Clicks the font color you want to use. The font color will 

change in the slide 

3.17 Use the 

Bold, Italic, 

and 

3.17.1 Selects the text you want to modify 

3.17.2 Clicks the Bold, Italic, or Underline command in the Font 

group on the Home tab 
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Skills 

Standard Criteria 

Underline 

commands 
3.17.3 Clicks the command again to remove the formatting 

3.18 Changing 

text 

alignment 

3.18.1 Selects the text you want to modify 

3.18.2 Selects one of the four alignment options from the Paragraph 

group on the Home tab 

3.18.3 Aligns Text Left, Center, Right or Justify 

3.19 Copy and 

paste text 

3.19.1 Selects the text you want to copy 

3.19.2 Clicks the Copy command on the Home tab 

3.19.3 Places your insertion point where you want the text to appear 

3.19.4 Clicks the Paste command on the Home tab. The text will 

appear 

3.20 Cut and 

paste text 

3.20.1 Selects the text you want to cut 

3.20.2 Clicks the Cut command on the Home tab 

3.20.3 Places your insertion point where you want the text to appear 
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Skills 

Standard Criteria 

3.20.4 Clicks the Paste command on the Home tab. The text will 

appear 

3.21 Drag and 

drop text 

3.21.1 Selects the text you want to copy. 

3.21.2 Clicks your mouse and drag the text to the location where you 

want it to appear. The cursor will have a text box beneath it to 

indicate that you are moving text 

3.21.3 Releases the mouse button, and the text will appear 

3.22 Insert a 

table using 

a 

placeholder 

command 

3.22.1 Selects the slide to insert a table 

3.22.2 Clicks the Insert Table command in the placeholder. The 

Insert Table dialog box will appear 

3.22.3 Enters the number of table columns and rows in the dialog 

box 

3.22.4 Clicks OK. The table will appear on the slide, and the Design 

and Layout tabs will appear on the Ribbon 
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Skills 

Standard Criteria 

3.22.5 Enters text into the table 

3.23 Applying a 

table style 

3.23.1 Selects the table. 

3.23.2 Selects the Design tab to access all Table Styles and Options 

3.23.3 Moves your cursor over a table style in the Table Styles group 

to see a live preview of the style on the slide 

3.23.4 Clicks the More drop-down arrow to see all available options 

3.23.5 Clicks a style to select it 

3.24 Changing 

table 

shading 

3.24.1 Selects the table 

3.24.2 Selects the Design tab 

3.24.3 Selects the rows or columns you want to modify 

3.24.4 Clicks the Shading command in the Table Styles group. 

3.24.5 Moves your cursor over a color option to see a live preview of 

the color on the slide 
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Skills 

Standard Criteria 

3.24.6 Clicks a color to select it 

3.25 Applying a 

border 

3.25.1 Selects the table 

3.25.2 Selects the Design tab 

3.25.3 Selects the rows or columns you want to modify 

3.25.4 Clicks the Borders command in the Table Styles group 

3.25.5 Selects a borders option from the menu 

3.26 Applying a 

table effect 

3.26.1 Selects the table 

3.26.2 Selects the Design tab 

3.26.3 Selects the rows or columns you want to modify 

3.26.4 Clicks the Effects command. A menu will appear 

3.26.5 Selects a menu option. The options are: Cell Bevel, Shadow, 

and Reflection. This will display a submenu 

3.26.6 Selects an effect option from the submenu 
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Skills 

Standard Criteria 

3.27 Inserting a 

row 

3.27.1 Selects the table 

3.27.2 Selects the Layout tab 

3.27.3 Places the insertion point in a row adjacent to where you want 

the new row to appear 

3.27.4 Clicks the Insert Below or Insert Above command 

3.28 Delete a 

row 

3.28.1 Selects the table 

3.28.2 Selects the Layout tab 

3.28.3 Place the insertion point in the row you want to delete 

3.28.4 Clicks the Delete command 

3.29 Inserting a 

column 

3.29.1 Selects the table 

3.29.2 Selects the Layout tab 

3.29.3 Places the insertion point in a column adjacent to the location 

where you want the new column to appear 

3.29.4 Clicks the Insert Right or Insert Left command 
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Skills 

Standard Criteria 

3.30 Delete a 

column 

3.30.1 Selects the table 

3.30.2 Selects the Layout tab 

3.30.3 Places the insertion point in the column you want to delete 

3.30.4 Clicks the Delete command 

3.30.5 Selects Delete Column from the menu 

3.31 Use 

another 

method to 

insert and 

delete 

rows and 

columns 

3.31.1 Places the insertion point in the row or column you want to 

delete 

3.31.2 Right-clicks the table and a menu appear 

3.31.5 Selects one of the Insert/Delete menu options 

3.32 Changing 

the text 

3.32.1 Selects the table 

3.32.2 Selects the Layout tab 
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Skills 

Standard Criteria 

alignment 

in a table 

3.32.3 Selects the cells you want to modify 

3.32.4 Clicks an alignment command to change the text alignment in 

the table. The alignment commands are: 

3.32.5 Aligns Text Left, Center, Right or  Bottom 

3.33 Inserting a 

table using 

Ribbon 

commands 

3.33.1 Selects the slide where you want to insert the table 

3.33.2 Selects the Insert tab on the Ribbon 

3.33.3 Clicks the Table command. A menu will appear 

3.33.4 Selects the number of columns and rows in the table 

3.33.5 Clicks to insert the table on the slide 

3.33.6 Enters text into the table 

3.34 Inserting a 

chart 

3.34.1 Selects the Insert tab 

3.34.2 Clicks the Insert Chart command. The Insert Chart dialog box 

appears 
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Skills 

Standard Criteria 

3.34.3 Clicks and drag the scroll bar to view the chart types, or click 

a label on the left of the dialog box to see a specific chart style 

3.34.4 Clicks a chart to select it 

3.34.5 Clicks OK 

3.35 Entering 

chart data 

3.35.1 Selects a cell in the Excel spreadsheet 

3.35.2 Enters your data in the cell 

3.35.3 Moves to another cell 

3.35.4 Repeats the above Criteria until all of your data is entered 

3.35.5 Clicks and drag the lower-right corner of the blue line to 

increase or decrease the data range for columns 

3.35.6 Clicks and drag the lower-right corner of the blue line to 

increase or decrease the data range for rows 
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Skills 

Standard Criteria 

3.35.7 Selects any cells with placeholder data remaining. In the 

example, the column with Series 3 data was not needed 

3.35.8 Presses the Delete key to delete the remaining placeholder 

data 

3.35.9 Closes Excel. You do not need to save the spreadsheet. The 

new Excel source data appears in the PowerPoint chart 

3.36 Using Print 

Preview 

3.36.1 Clicks the Microsoft Office button/File 

3.36.2 Selects Print 

3.36.3 Selects Print Preview. The presentation opens in Print 

Preview format 

3.36.4 From here, you can view each slide in grayscale, make 

decisions about whether to print the slides individually or as 

handouts 

3.36.5 Chooses  various other options 
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Skills 

Standard Criteria 

3.37 Printing  3.37.1 Clicks the Microsoft Office button 

3.37.2 Selects Print, The Print dialog box appears 

3.37.3 Selects the printer you want to use if you have more than 1 

printer 

3.37.4 Clicks Properties. From here, you can make choices on paper 

size and whether to print on both sides. These options vary 

from printer to printer 

3.37.5 Enters a print range 

3.37.6 Leaves the default setting, All, selected, or clicks Slides 

3.37.7 Enters the slide numbers of the slides you want to print 

3.37.8 Decides what you want to print: slides, handouts, notes pages, 

or an outline 

3.37.9 Chooses horizontal or vertical slide layout, if given the option 

3.37.10Chooses the number of copies to print 
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Skills 

Standard Criteria 

3.37.11Clicks OK 

 

  



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 189 

 

Checklist 4: Create an email account, sign in and send email to supervisor with 

attachment 

Skills 

Standard Criteria 

4.1 Creating an 

Email 

account 

4.1.1 Opens a browser 

4.1.2 Enters website address  

4.1.3 Clicks on the mail button 

4.1.4 Creates a new account 

4.1.5 Enters all required particulars 

4.1.6 Clicks create account 

4.2 Sending an 

email 

4.2.1 Logs In, into your Email account 

4.2.2 Clicks the Compose button on the left side of your home 

page  

4.2.3 Types an email address 

4.2.4 Types the subject  

4.2.5 Enters the message 
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Skills 

Standard Criteria 

4.2.6 Clicks Send icon 

4.3 Adding an 

attachment 

4.3.1 Composes a message 

4.3.2 Clicks Browse to a locate a file  

4.3.3 Selects a file 

4.3.4 Clicks Open icon 

4.4 Adding a 

signature 

4.4.1 Open the Settings menu 

4.4.2 Find the Signature section 

4.4.3 Type your signature 

4.4.4 Add links to your signature 

4.5 Reading an 

email 

4.5.1 From your inbox, click the email you want to read 

4.5.2 The email will open in the same window 

4.6 Opening an 

attachment 

4.6.1 Opens the email message that contains the attachment 

4.6.2 Clicks Download 

4.6.3 Clicks Open in the Download dialog box 
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Skills 

Standard Criteria 

4.7 Replying to 

an email 

message 

4.7.1 Views a message 

4.7.2 Clicks Reply at the bottom of the message 

4.7.3 Type a message in the Body field 

4.7.4 Clicks Send 

4.8 Forwarding 

an email 

message 

4.8.1 Views a message 

4.8.2 Clicks Forward at the bottom of the message 

4.8.3 Types a recipient's email address  

4.8.4 Types a message in the Body field 

4.8.5 Clicks Send 

 43.3.1. Writes a prompt or question  

43.3.2. Sets a variable or field data type  

43.3.3. Clicks “OK” 

43.1. Enter data 43.4.1. Clinks “Enter data” command In  the main page of Epi 

Info 
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Skills 

Standard Criteria 

43.4.2. Selects a "File"  

43.4.3. Clicks on "Open" 

43.4.4. Selects the directory and choose the project file 

43.4.5. Selects a table 

43.4.6. clicks "OK" 

43.2. Import data 43.5.1. Clicks "Analyze data" In the main page of Epi Info 

43.5.2. Clicks "Read (import)" in the panel at the left side of the 

screen 

43.5.3. Clicks “Change Project” 

43.5.4. Selects the project file from your directory "; 

43.5.5. Clicks "Open 

43.5.6. Selects the table within the project file you want to open; 

43.5.7. Clicks "OK" 

43.3. Export data 43.6.1. Clicks on "Write (export)" in the panel on the left 
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Skills 

Standard Criteria 

43.6.2. Selects the type of file in Output formats 

43.6.3. Clicks on the browse button to go to your directory 

43.6.4. Types a name for the file you are exporting 

43.6.5. Clicks "OK" 

43.4. Analyse 

data 

43.7.1. Clicks "Analyze data" In the main page of Epi Info 

43.7.2. Clicks on "Read (import)" in the panel at the left side of 

the screen 

43.7.3. Clicks “Change Project” 

43.7.4. Selects the project file from your directory  

43.7.5. Clicks "Open" 

43.7.6. Selects the table within the project file you want to open; 

43.7.7. Clicks “OK” 

43.7.8. Selects a type of analysis command in the Analysis 

Command Tree 



Practicum Guide for Tutors and Practical Instructors NTA Level 4 Medical Laboratory Sciences 

 194 

 

Skills 

Standard Criteria 

43.5. Create a 

report 

43.8.1. Clicks "Create reports" in the main page of Epi Info 

43.8.2. Selects a file button in the Epi Report window 

43.8.3. Clicks generate report 
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Practicum Module: MLT04210 Systemic Human Anatomy and Physiology 

 

 

 

Total Practical Time: 20 hours in 20 weeks of a semester  

 

Aim: The aim of this practicum is for students to acquire skills of human anatomy and 

physiology in providing health care services. 

 

Practical Learning Outcomes: 

By the end of practicum the students will be able to: 

• Locate  different sites and name blood vessels for blood collection 

• Locate   parts of respiratory system for collection of specimen 

• Locate sites for collecting eye swab  

• Locate sites for collecting ear swab 

• Locate sites for collecting tongue scrapings 

• Locate sites for collecting skin specimens 
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• Locate sites for collecting nasal swab 

• Locate sites for collecting gastrointestinal specimens  

• Locate sites for collecting specimens of the urinary system  

Competencies/Skills 

• Identify and name  different sites for blood collection 

• Identify and name  different sites and name blood vessels for blood collection 

• Identify and name   parts of respiratory system for collection of specimen 

• Identify and name sites for collecting eye swab  

• Identify and name sites for collecting ear swab 

• Identify and name sites for collecting tongue scrapings 

• Identify and name sites for collecting skin specimens 

• Identify and name sites for collecting nasal swab 

• Identify and name sites for collecting gastrointestinal specimens  

• Identify and name sites for collecting specimens of the urinary system  

Practicum Resources 

• Practicum learning Outcomes 
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• Manikins 

• Charts 

• Models 

 

Prerequisite modules 

• MLT04102 General Human Anatomy and Physiology 

 

Areas of Practice and Assignment 

Students will have an opportunity while on placement in the Skill laboratory to familiarise with 

different parts of the human body for specimen collection. Tutors and skills laboratory 

instructors shall ensure that students learn the following activities: 
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Activity 1: Skill laboratory 

At the end of theory session which contain practical component(s) students shall be divided 

in small manageable groups (4-6 students) and assigned to identify and name specific sites 

in the human body used for collections of different specimen. 
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Practicum Module: MLT04211: Laboratory Reagents and Solution 

 

 

 

Total Practical Time: 80 hours in 20weeks of a semester 

 

Aim: The aim of the practicum is for students to prepare, store, verify and document reagents 

and solutions used for laboratory investigations. 

 

Clinical Learning Outcomes 

• Prepare clinical laboratory reagents and solutions according to SOPs Administer 

medications to patients 

• Verify the quality of reagents and solutions to ensure reliable laboratory results. 

• Store reagents and solutions in the laboratory as per guideline or SOP 

Competencies/Skills 

• Use standard unit conversions for preparation of different concentrations of reagents  
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• Prepare Giemsa stain solution 

• Prepare Field Stain A and B solutions 

• Prepare Auramine phenol staining reagent 

• Prepare Turk’s solution  

• Prepare Gram staining solutions  

• Prepare ZN staining solution 

• Label prepared reagents and solutions 

• Verify quality performance of reagents prepared 

• Document stored reagents and solutions in the laboratory 

 

Practicum Resources 

• Practicum checklists  

• Practical learning outcomes  

• Practical rotation plan 

• Practical assignment sheets 

• All other necessary equipments and supplies  
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Prerequisite modules 

• MLT 04101 Laboratory Instrumentation 

• MLT 04103 Laboratory safety and waste management 

 

Practical Placement 

During placement in health facility laboratory departments and teaching laboratories, student 

will get the opportunity to observe and practice the preparation, storage and quality checks of 

different reagents and solutions used in laboratory investigations. Through assignments and 

demonstrations, students will acquire skills and see how those skills are applied in diverse 

settings.  
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Activity 1: Preparation of Reagents and Solutions 

Students shall be divided into small manageable groups (4 to 6 

students per group) that will rotate in the reagents preparation rooms 

to observe and practice the following: 

• Prepare Giemsa stain solution 

• Prepare Field stain A and B solutions 

• Prepare Auramine staining reagent 

• Prepare Turk’s solution  

• Prepare Gram staining solutions  

• Prepare ZN staining solution 

 
Assignment 1 

Each student shall prepare Giemsa stain, Field stain A and B, 

Auramine stain, Turk solution, Gram stain and ZN stain; and submit 

those reagents to the practical instructor for assessment. 

 
Assignment 2 
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From the prepared reagents and solution above:    

• Students shall be provided with old prepared batch of reagents 

and be required to verify quality performance of prepared 

Giemsa stain, Field stain A and B, Auramine stain, Turk 

solution, Gram stain and ZN stain 

Write the report and submit to the tutor for assessment and grading  
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Checklist 1: Preparation of Giemsa stock solution 

Skill 

Standard Criteria  

1.1 Procedure for 

Preparation of 

Giemsa solution  

1.1.1 Assembles important equipment, materials and supplies  

• Measuring Graduated cylinder 

• Flasks (volumetric) 

• Pipettes 

• Weighing Balance 

• Spatula 

• Water bath 

• Brown bottle 

• Para film 

• Label or tape 

• Marker pen 
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Skill 

Standard Criteria  

• Distilled Water or filtered Rain water  

• Absolute methanol 

• Glycerol 

• Giemsa powder 

1.1.2 Weighs out 3.8 g of Giemsa powder  

1.1.3 Places in the flask 

1.1.4 Adds 250 mL methanol 

1.1.5 Mixes well 

1.1.6 Adds 250 ml glycerol 

1.1.7 Mixes well 

1.1.8 Heats to 60oC for 90 minutes until powder is 

completely dissolved 

1.1.9 Allows the stain to cool down 
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Skill 

Standard Criteria  

1.1.10 Labels Giemsa stain using tape and marker pen  

1.1.11 Stores the prepared Giemsa reagent in storage bottle 

(brown bottle) 
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Checklist 2: Preparation of Field Stain “A” and “B” solutions 

 

Skill 

Standard Criteria  

2.1 Procedure for 

preparation 

field stain “A” 

and “B” 

2.1.1 Assembles the important equipment, materials and supplies: 

• Measuring Graduated cylinder 

• Flasks (volumetric) 

• Pipettes 

• Weighing Balance 

• Spatula 

• Water bath (above 1000C) 

• Parafilm 

• Label or tape 

• Marker pen 

• Distilled Water or filtered Rain water 

• Field stain A powder 
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Skill 

Standard Criteria  

• Field stain B powder 

2.1.2 Heats 600 ml distilled water to boiling 

2.1.3 Weighs out 6 g of Field stain A powder and add to 500 ml 

volumetric flask containing some hot water 

2.1.4 Mixes by swirling to dissolve 

2.1.5 Adds the remaining volume of distilled water to make 500 ml. 

2.1.6 Parafilms and mixes thoroughly 

2.1.7 Filters stain 

2.1.8 Stores stain in brown bottle 

2.1.9 Labels Field Stain A using tape and marker pen  

Field stain “B” 

2.1.10 Heats 600 ml in distilled water to boiling 
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Skill 

Standard Criteria  

2.1.11 Weighs out 5 g of Field stain B powder and add to 500 ml 

volumetric flask containing some hot water 

2.1.12 Mixes by swirling to dissolve 

2.1.13 Adds the remaining volume of distilled water to make 500 ml 

2.1.14 Parafilms and mixes thoroughly 

2.1.15 Filters stain 

2.1.16 Stores stain in brown bottle 

2.1.17 Labels Field Stain B using tape and marker pen  
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Checklist 6: Preparation of Ziehl Neelsen staining solutions 

 

Skill 

Standard Criteria  

6.1 Procedure for 

preparation of 

ZN solutions 

Assembles important equipment, materials and supplies: 

• Measuring Graduated cylinder 

• Flasks (volumetric) 

• Weighing Balance 

• Para film 

• Label or tape 

• Marker pen 

• Distilled Water or filtered Rain water 

• Basic Fuchsin 

• Absolute methanol 

• 0.3% Methylene blue 

• Phenol crystals 
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Skill 

Standard Criteria  

  

Preparation of 20% sulphuric acid 

6.1.1 Measures 20 ml concentrated sulphuric acid and transfers to a 

leak-proof container 

6.1.2 Measures 80 ml of distilled water 

6.1.3 Transfers 20ml of sulphuric acid into the container with 80ml 

of distilled water 

6.1.4 Labels the bottle 

6.1.5 Stores at room temperature in a safe place. The reagent is 

stable indefinitely 
 Preparation of 0.3% Methylene Blue 

6.1.6 Weighs out 0.3 g of methylene blue using a balance 
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Skill 

Standard Criteria  

6.1.7 Adds 0.3 g methylene blue to a 100 mL volumetric flask 

containing some distilled water 

6.1.8 Mixes by swirling to dissolve 

6.1.9 Adds the remaining volume of distilled water  

6.1.10 Parafilms and mixes thoroughly 

6.1.11 Labels using tape and marker pen  
 Preparation of Strong Carbol Fuchsin    

6.1.12 Dissolves 1g basic fuchsin in 10 mL absolute methanol in a 

flask 

6.1.13 Dissolves 4.5g phenol crystals in 90 mL distilled water in 

separate flask 

6.1.14 Mixes the 2 solutions in a 100 mL flask 

6.1.15 Filters stain into a brown bottle  
 6.1.16 Labels using tape and marker pen  
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Checklist 4: Preparation of Turk’s Reagent 

 

Skill 

Standard Criteria  

4.1 Procedure for 

preparation of 

Turk’s 

reagent 

Assembles important equipment, materials and supplies: 

• Glacial acetic acid 

• 0.5% gentian violet solution 

• Measuring Graduated cylinder 

• Flasks (volumetric) 

• Label or tape 

• Marker pen 

• Distilled Water or filtered Rain water 

4.1.1 Measures 980 ml distilled into a flask 

4.1.2 Adds 20 ml glacial acetic acid to the flask 

4.1.3 Adds 2-3 drops of 0.5% Gentian violet solution 

4.1.4 Transfers stain to a clean reagent bottle  

 4.1.5 Labels using tape and marker pen  
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Checklist 5: Preparation of Gram Stain Solutions 

Skill 

Standard Criteria  

5.1 Procedure for 

preparation of 

Gram stain 

solutions 

Assembles important equipment, materials and supplies: 

• Glacial acetic acid 

• 0.5% gentian violet solution 

• Measuring Graduated cylinder 

• Flasks (volumetric) 

• Label or tape 

• Marker pen 

• Distilled Water or filtered Rain water 
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5.2  Preparation of Crystal Violet Solution 

5.2.1 Dissolves 2.0 g of crystal violet into 20.0 ml of 95% ethyl 

alcohol 

5.2.2 Dissolves 0.8 g ammonium oxalate into 80.0 ml distilled 

water 

5.2.3 Mixes the two solutions together and allow them to stand 

overnight at room temperature  

5.2.4 Filter through coarse filter paper before use 

5.2.5 Stores at room temperature 

Preparation of Gram’s iodine (lugol’s iodine) 

5.2.6 Weighs 1.0g of iodine and 2.0g of potassium iodide 

5.2.7 Grinds 1.0 g iodine (crystalline) and 2.0 g potassium iodide in 

a mortar 

5.2.8 Adds to 300.0 ml distilled water 

5.2.9 Stores at room temperature in a foil-covered bottle (to protect 

solution from light) 
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 Preparation of 10% acetone in alcohol 

 5.2.10 Measures 10 ml of acetone and 90ml of ethanol or methanol 

 5.2.11 Adds acetone to alcohol and mix 

 5.2.12 Label the bottle, and mark it Highly Flammable 

 5.2.13 Store in a safe place at room temperature 

 Preparation of Safranin-O 

 5.2.14 Weighs 2.5g salfranin-O  

 5.2.15 Measures 100mls of 95% ethyl alcohol 

 5.2.16 Measures 90mls of distilled water 

 5.2.17 Adds 2.5 g safranin-O to 100.0 ml 95% ethyl alcohol 

 
5.2.18 Adds a mixture of safranin-O and ethyl alcohol to 90.0 ml 

distilled water 

 5.2.19 Labels using tape and marker pen 

 5.2.20 Stores at room temperature  

 Preparation of dilute carbol-fuchsin 

 5.2.21 Weighs 0.3g of carbol-fuchsin  

 5.2.22 Measures 10mls of 95% ethyl alcohol 

 5.2.23 Measures 5 mls of melted phenol crystals 
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 5.2.24 Measures 95 mls of distilled water 

 5.2.25 Dissolves 0.3 g basic fuchsin in 10.0 ml 95% ethyl alcohol 

 5.2.26 Adds 5.0 ml melted phenol crystals to 95.0 ml distilled water 

 
5.2.27 Adds the 5% phenol solution to the fuchsin solution and let 

stand overnight 

 5.2.28 Filters through coarse filter paper 

 5.2.29 Labels using tape and marker pen 

 5.2.30 Stores at room temperature in a foil-covered bottle  
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Checklist 3: Preparation of Auramine Phenol solution 

 

Skill 

Standard Criteria  

3.1 Procedure 

for 

preparation 

of Auramine 

solution   

3.1.1 Weighs 1.0 g of Auramine powder and 30 g of phenol crystals 

separately 

3.1.2 Measures 100 ml of alcohol and 870 ml of distilled water 

separately 

3.1.3 Combines alcohol and Auramine powder in a conical flask and 

stir until Auramine dissolved 

3.1.4 Adds phenol crystals to water and stir until dissolved 

3.1.5 Combines the two solutions   

3.1.6 Adds distilled water to fill to a total volume of 1L 

3.1.7 Performs Quality Control  
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Skill 

Standard Criteria  

3.1.8 Labels using tape and marker pen 

 3.1.9 Stores in room temperature 
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